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Introduction

Welcome to Adobe InDesign CS4 On Demand, a visual quick
reference book that shows you how to work efficiently with
InDesign.  This book provides complete coverage of basic to
advanced InDesign skills.

How This Book Works
You don’t have to read this book in any particular order.
We’ve designed the book so that you can jump in, get the
information you need, and jump out. However, the book does
follow a logical progression from simple tasks to more com-
plex ones. Each task is presented on no more than two facing
pages, which lets you focus on a single task without having
to turn the page. To find the information that you need, just
look up the task in the table of contents or index, and turn to
the page listed. Read the task introduction, follow the step-
by-step instructions in the left column along with screen illus-
trations in the right column, and you’re done.

What’s New
If you’re searching for what’s new in InDesign CS4, just look
for the icon: New!. The new icon appears in the table of con-
tents and throughout this book so you can quickly and easily
identify a new or improved feature in InDesign. A complete
description of each new feature appears in the New Features
guide in the back of this book.

Keyboard Shortcuts
Most menu commands have a keyboard equivalent, such as
Ctrl+P (Win) or A+P (Mac), as a quicker alternative to using
the mouse. A complete list of keyboard shortcuts is available
on the Web at www.perspection.com.

How You’ll Learn

How This Book Works

What’s New

Keyboard Shortcuts

Step-by-Step Instructions

Real World Examples

Workshops

Adobe Certified Expert

Get More on the Web

www.perspection.com
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Step-by-Step
Instructions
This book provides concise step-
by-step instructions that show you
“how” to accomplish a task. Each
set of instructions includes illus-
trations that directly correspond to
the easy-to-read steps. Also
included in the text are time-
savers, tables, and sidebars to
help you work more efficiently or
to teach you more in-depth infor-
mation. A “Did You Know?” pro-
vides tips and techniques to help
you work smarter, while a “See
Also” leads you to other parts of
the book containing related infor-
mation about the task. 

Real World Examples
This book uses real world exam-
ple files to give you a context in
which to use the task. By using
the example files, you won’t waste
time looking for or creating sam-
ple files. You get a start file and a
result file, so you can compare
your work. Not every topic needs
an example file, such as changing
options, so we provide a complete
list of the example files used
throughout the book. The example
files that you need for project
tasks along with a complete file
list are available on the Web at
www.perspection.com.

Real world
examples help
you apply what
you’ve learned
to other tasks.

Illustrations
match the
numbered
steps.

Numbered
steps guide
you through
each task.

Did You Know? alerts
you to tips, techniques
and related information.

See Also points you to
related information in
the book.

Easy-to-follow
introductions
focus on a
single concept.

www.perspection.com


The Workshop
walks you
through in-depth
projects to help
you put InDesign 
to work.

Introduction xix

Workshops
This book shows you how to put
together the individual step-by-
step tasks into in-depth projects
with the Workshop. You start each
project with a sample file, work
through the steps, and then com-
pare your results with a project
results file at the end. The Work-
shop projects and associated files
are available on the Web at
www.perspection.com.

Adobe Certified Expert
This book prepares you fully for
the Adobe Certified Expert (ACE)
exam for Adobe InDesign CS4.
Each Adobe Certified Expert certifi-
cation level has a set of objec-
tives, which are organized into
broader skill sets. To prepare for
the certification exam, you should
review and perform each task
identified with a Adobe Certified
Expert objective to confirm that
you can meet the requirements for
the exam. The Adobe Certified
Expert objectives are available on
the Web at www.perspection.com.

Logo indicates a
task fulfills one or
more Adobe
Certified Expert
objectives.

www.perspection.com
www.perspection.com
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Get More on the Web
In addition to the information in
this book, you can also get more
information on the Web to help
you get up-to-speed faster with
InDesign CS4. Some of the infor-
mation includes: 

Transition Helpers
◆ Only New Features.

Download and print the new
feature tasks as a quick and
easy guide.

Productivity Tools
◆ Keyboard Shortcuts.

Download a list of keyboard
shortcuts to learn faster ways
to get the job done. 

More Content
◆ Photographs. Download

photographs and other
graphics to use in your
InDesign documents. 

◆ More Content. Download
new content developed after
publication.

You can access these additional
resources on the Web at
www.perspection.com.

Additional
content
is available
on the Web. 

www.perspection.com
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Managing Pages and Books

Introduction

Most documents are more than one page, so inserting new
pages is a common practice in InDesign. You can quickly add
a new blank page to a document using the Pages panel. The
Pages panel allows you to visually display and navigate
through all the pages in your document. When you work with
multiple page documents, moving pages around is
inevitable. You can simply drag pages in the Pages panel to
rearrange them within a document or use the Move Page
command on the Options menu to move them between doc-
uments. When you no longer need a page, you can quickly
delete it from your document using the Pages panel. 

A master page is one of the most important parts of creat-
ing an InDesign document. A master page holds and displays
all the elements that you want to appear on every page in a
document, such as headers, logos, page numbers, and foot-
ers. The master is like a background layer to a page.
Everything on the background layer appears on the page in
front of it. When you make a change to a master page, the
change appears in all document pages unless you override
the change.

Instead of creating long documents, you can break them
up into smaller documents, like chapters, and then add them
to a book. In InDesign, a book is not a single document. It
simply keeps track of all the documents in the book and coor-
dinates document page numbers, colors, and styles. When
you create a book, you can synchronize page numbers, col-
ors, and styles for all the documents in the book. Each book
uses a file called the style source to control the style sheets,
swatches, and master pages for all the documents in the
book. When you make changes to the style source file, all the
documents in the book are synchronized to the file. 

What You’ll Do

Use the Pages Panel

Insert Pages

Navigate Pages

Delete or Move Pages

Work with Page Spreads

Rotate Page Spreads

Create Master Pages

Work with Master Pages

Work with Page Numbers and Sections

Work with Chapter Numbers

Create and Use Text Variables

Create a Book

Manage Books

Create a Table of Contents

Adjust Layouts
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Using the Pages Panel

Change the Pages Panel Display

Select the Pages panel.

◆ You can also click the Window
menu, and then click Pages.

Click the Options menu on the
panel, and then click Panel
Options.

Select from the following Pages
panel options:

◆ Size. Specify an icon size for
Pages and Masters.

◆ Show Vertically. Select to show
page or master page icons
vertically.

◆ Show Thumbnails. Select to
show page or master page
icons as thumbnails.

Click the Pages on Top or Masters
on Top option.

Click the Resize list arrow, and
then select an option when you
resize the Pages panel. 

Click OK.6

5

4

3

2

1

The Pages panel allows you to visually display all the pages in your
document. The Pages panel shows thumbnails for each page. At the
top of the panel are the master pages for the document. A master page
contains elements that are repeated on every page. When you’re work-
ing with a multi-page document, the Pages panel is an essential part of
working with pages. You can add and remove pages as well as navi-
gate to and from pages. The Pages panel, like all panels, provides an
Options menu where you can select page-related commands and
Pages panel display options. The display options allow you to change
page icons size, position, and location. In addition, you can also set
options to show or hide icons for page transparency, transition, and
spread rotation (New!).

1

6

2

3

4

5
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Show or Hide Pages Panel Icons

Select the Pages panel.

◆ You can also click the Window
menu, and then click Pages.

Click the Options menu on the
panel, and then click Panel
Options.

Select from the following options
for icon display:

◆ Transparency. Select to display
icons when transparency is
applied to a page or spread. 

◆ Spread Rotation. Select to
display icons when the spread
view is rotated.

◆ Page Transitions. Select to
display icons when page
transitions are applied to a page
or spread.

Click OK.4

3

2

1 1

4

3

2
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Inserting Pages

Insert Pages Using the Pages
Panel

Select the Pages panel.

◆ You can also click the Window
menu, and then click Pages.

Use any of the following methods
to insert a page:

◆ Insert Page. Click the Create
New Page button on the panel.

◆ Insert from Master Pages. Drag
a master page or a nonmaster
page from the master page
area to the document page
area of the panel.

Continue to insert pages as
needed.

3

2

1

Most documents will be more than one page, so inserting new pages is
a common practice in InDesign. You can quickly add a new blank page
to a document using the Pages panel. You have several different meth-
ods to complete the task. You can use the New Page button on the
page, drag a master page to the document area in the Pages panel, or
use the Insert Pages command on the Options menu. If you’re inserting
only one or two pages, the first two methods work the best. If you want
to insert multiple pages, the Insert Pages command is your best option,
where you can use the Insert Pages dialog box to set additional
options.

Did You Know?
You can duplicate a page. Select the
Pages panel, select the pages or
spreads you want to duplicate, and
then drag the selected pages to the
Create New Page button on the panel
or use the Duplicate Spread command
on the Options menu. 

1

2

New page
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Insert Multiple Pages Using the
Insert Pages Dialog Box

Select the Pages panel.

◆ You can also click the Window
menu, and then click Pages.

Click the Options menu, and then
click Insert Pages.

Enter the number of pages that you
want to insert.

Click the Insert list arrow, and then
specify how you want to insert the
pages:

◆ After Page. Inserts new pages
after a specific page.

◆ Before Page. Inserts new pages
before a specific page.

◆ At Start of Document. Inserts
new pages at the start of the
document.

◆ At End of Document. Inserts
new pages at the end of the
document.

Specify the specific page to use
when you choose After Page or
Before Page as your Insert option.

Click the Master list arrow, and
then select a master or nonmaster
page to use as the basis for the
new pages.

Click OK.7

6

5

4

3

2

1

1

2

3 74

6 5
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Navigating Pages

Target or Activate on a Page

Select the Pages panel.

◆ You can also click the Window
menu, and then click Pages.

Use any of the following methods
to select a page:

◆ Target a Page. Click a page in
the Pages panel. 

The thumbnail is highlighted.

◆ Work on (Activate) a Page.
Double-click a page in the
Pages panel.

The thumbnail is highlighted and
the page number or name below
it is highlighted in black.

2

1

After you insert new pages into a document, you can use the Pages
panel, Layout menu commands, and Status bar to navigate between
them. As you work with pages in the Pages panel, there are two types
of page selections. One targets a page and the other activates a page.
A targeted page is a page selected in the Pages panel, while an acti-
vated page is a working page in the document window. When you 
target a page, you can apply a command in the Pages panel even
though it may not be the current working page in the document
window.

1

Active page

Targeted page
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Navigate to Pages

◆ Pages Panel. Select the Pages
panel, and then double-click the
page in the panel that you want to
work on.

◆ Status Bar. Use the navigation
buttons on the Status bar to
browse through pages or click the
list arrow to select a specific page.

◆ Layout Menu. Click the Layout
menu, and then select any of the
following commands:

◆ First Page. Displays the first
page in the document. 

◆ Previous Page. Displays the
previous page in the document. 

◆ Next Page. Displays the next
page in the document. 

◆ Last Page. Displays the last
page in the document. 

◆ Next Spread. Displays the next
spread of pages in the
document.

◆ Previous Spread. Displays the
previous spread of pages in the
document.

◆ Go To Page. Displays the
specified page in the document. 

◆ Go Back. Displays the
previously active page in the
document.

◆ Go Forward. Displays the
previously active page before
the use of the Go Back
command.

Pages panel

Status bar with page navigation

Layout menu with page navigation 
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Deleting or Moving
Pages

Delete Pages

Select the Pages panel.

◆ You can also click the Window
menu, and then click Pages.

Select the pages that you want to
delete.

◆ You can use the Shift key to
select contiguous pages or the
Ctrl (Win) or A (Mac) to select
noncontiguous pages.

Click the Delete Page button on the
panel.

◆ You can also click the Options
menu, and then click Delete
Pages.

IMPORTANT When you have a
spread of pages selected, the
button and command changes to
Delete Spreads.

Click OK to confirm the deletion.

TIMESAVER Hold down the Alt
(Win) or Option (Mac) key, when
you select the Delete Pages button
or command to bypass the
confirmation dialog box.

4

3

2

1

When you no longer need a page, you can delete it from your document
using the Pages panel. You can use the Delete Page or Delete Spread
button on the panel or the same command on the Options menu.
Moving and arranging pages is a common part of working with multiple
page documents. You can simply drag pages in the Pages panel or use
the Move Page command on the Options menu. When you drag pages,
the cursor indicates new page location. With the Move Page command,
you can move pages within the current document or to another open
document. When you move the pages, objects in the slug and bleed
areas are also moved (New!). Page numbers in the slug area display a
number rather than the pasteboard index entry (New!).

1

2

3
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Move Pages by Dragging

Select the Pages panel.

Click the Options menu, and then
select a move related option:

◆ Allow Document Pages to
Shuffle. Enables or disables the
shuffling of document pages.

◆ Allow Selected Spread to
Shuffle. Enables or disables the
shuffling of selected spread
pages.

Drag a page next to or between
spread pages.

A straight black line indicates the
move location with a shuffle. A
bracket black line indicates the
move location with attachment.

Move Pages

Select the Pages panel.

Click the Options menu, and then
click Move Pages.

Specify the pages that you want to
move. Use a hyphen to designate a
range, such as 1-4.

Click the Destination list arrow,
select an option, and then enter a
page number, if necessary.

Click the Move To list arrow, and
then select a document location.

If you are moving the page(s) to a
separate open file, select the
Delete Pages After Moving check
box if you want to delete the pages
from the current document.

Click OK.7

6

5

4

3

2

1

3

2

1 1

1

2

3 Move with
attachment

6 5

2

4

7

3
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Working with Page
Spreads

Add and Remove Pages from a
Spread

Select the Pages panel.

Click the Options menu on the
panel, and then click Allow
Document Pages to Shuffle to
deselect it.

To add pages, drag a page from
the pages area, or a master page
next to the spread where you want
to add the page.

To remove pages, drag a page
from the spread to outside of the
spread, and then click No, if
necessary.

4

3

2

1

Most documents are either one or two page spreads. A single-page
spread displays pages one at a time (top to bottom), while a two-page
spread displays pages as facing pages (left and right). If you want to
create a larger spread for a magazine foldout or a brochure, you can
add more pages to a one or two page spread. These multiple-page
spreads are also called island spreads. When you no longer want a
larger spread, you can remove pages from the spread.

Did You Know?
You can keep pages in a spread
together. Select the Pages panel,
select the spread you want to protect,
click the Options menu, and then click
Allow Selected Spread To Shuffle to
deselect it. 

1

2

3

4
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If you need to work on non-horizontal design elements, such as a cal-
endar, you can rotate the current spread in 90 degree increments
(New!) to make it easier to work on. When you rotate the current
spread view, you have full editing capabilities. When you’re done, you
can quickly clear the rotation to return to a normal view. 

Rotating Page Spreads

Rotate Page Spreads

Select the Pages panel.

Double-click the page numbers of
the page spread you want to
rotate.

Click the Options menu on the
panel, point to Rotate Spread
View, and then click 90° CW, 90°
CCW, or 180°.

◆ You can also click the View
menu, point to Rotate Spread,
and then click 90° CW, 90°
CCW, or 180°.

A rotation icon appears next to the
page indicating the spread is
rotated.

Edit and modify the page spread
the way you want.

Click the Options menu on the
panel, point to Rotate Spread
View, and then click Clear
Rotation.

◆ You can also right-click (Win)
or Control-click (Mac) the
rotation icon to select a
rotation spread command.

5

4

3

2

1

See Also
See “Using the Pages Panel” on pages
56-57 for more information on showing
the spread rotation icon in the Pages
panel.

1

4

3

2
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Creating Master Pages

Add Objects to an Existing
Master Page

Select the Pages panel.

◆ You can also click the Window
menu, and then click Pages.

Double-click the master page in
the master page area of the Pages
panel.

The master page or two page
spread appears in the document
window.

Add text boxes, graphics, or any
other elements you want on the
page.

Double-click a page in the
document page area of the Pages
panel.

The elements added to the master
page or spread appear on the
document page.

4

3

2

1

A master page holds and displays all the elements that you want to
appear on every page in a document, such as headers, logos, page
numbers, and footers. The master is like a background layer to a page.
Everything on the background layer appears on the page above it.
Master elements appear on document pages surrounded by a dotted
border to make them easy to identify. When you create a new docu-
ment, you also create a master page. If you want to create additional
master pages, you can create them from scratch or from an existing
page or spread.

Did You Know?
You can load master pages from
another document. Select the Pages
panel, click the Options menu, click
Load Master Pages, select the file, and
then click Open. 

ID 1.1, 2.11

1

2

4

3
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Create a Master Page from an
Existing Page

Select the Pages panel.

◆ You can also click the Window
menu, and then click Pages.

Drag a page or a spread from the
document page area to the master
page area.

◆ You can also select a page or
spread, click the Options menu,
and then click Save As Master.

Create a Master Page from
Scratch

Select the Pages panel.

◆ You can also click the Window
menu, and then click Pages.

Click the Options menu on the
panel, and then click New Master.

Select from the following Pages
panel options:

◆ Prefix. Enter a prefix up to four
characters. This identifies the
applied master for each page.

◆ Name. Enter a name for the
master page.

◆ Based on Master. Select an
existing master on which to
base the new master.

◆ Number of Pages. Enter the
number of pages (1-10) you
want in the master spread.

Click OK.4

3

2

1

2

1

1

New
master
page

2

4

3
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Working with Master
Pages

Apply a Master Page to a
Document Page

Select the Pages panel.

◆ You can also click the Window
menu, and then click Pages.

Drag a master page or spread
from the master page area to a
page or spread in the document
page area.

To apply a master to multiple
pages, select the pages in the
document page area, and then Alt
(Win) or Option (Mac) the master
page you want to apply.

◆ You can also click the Options
menu, click Apply Master To
Pages, specify the options you
want, and then click OK.

3

2

1

When you apply a master page to a document page, all the elements on
the master page are attached and displayed on the document page.
When you only want a selected number of elements from the master
page on a document page, you can override or detach the elements
you want. Overriding a master puts a copy of the master element on the
document page and keeps the link, where you can make changes to it.
The changes made on the document page don’t affect the master; how-
ever, any changes to the same element on the master (separate from
the document page) still appear from the master on the document
page. Detaching a master overrides a master element and removes the
link. Instead of overriding or detaching master elements, you have the
option of hiding them

Did You Know?
You can change master page options.
Select the Pages panel, select the
master page, click the Options menu,
click Master Options for master page
name, specify the options you want,
and then click OK.

ID 1.1, 2.11, 6.4

1

2 Selected master page
applied to page
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Work with Master Pages 

◆ Delete Masters. In the Pages
panel, drag a master page you
want to delete to the Delete
Selected Pages button on the
panel.

◆ Copy Masters. In the Pages panel,
drag a master page you want to
copy to the Create New Page
button on the panel.

◆ Hide Master Elements. In the
Pages panel, select the document
page, click the Options menu, and
then click Hide Master Items.

◆ Override a Master Element. In the
Pages panel, click the Options
menu, and then click Allow
Master Item Overrides On
Selection to select it. On a
document page, Ctrl+Shift+click
(Win) or A+Shift+click (Mac) an
element.

◆ You can also click the
document page in the Pages
panel, click the Options menu,
and then click Override All
Master Page Items.

◆ Detach a Master Element. On a
document page, Ctrl+Shift+click
(Win) or A+Shift +click (Mac) an
element to override it (see above).
In the Pages panel, click the
Options menu, and then click
Detach Selection From Master.

◆ You can also click the Options
menu, and then click Detach
All Objects From Master.

◆ Unassign Master. In the Pages
panel, drag the [None] master
from the master page area to a
page in the document page area.

All master elements are no longer
attached to the document page.

Create New Page

Delete Selected Pages

Page
Options
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Working with Page
Numbers and Sections

Add a Page or Section Number
to a Page Master

Select the Pages panel.

◆ You can also click the Window
menu, and then click Pages.

Double-click the master page in
the master page area of the Pages
panel.

The master page or two page
spread appears in the document
window.

Select the Type tool on the Tools
panel.

Click where you want to create a
text box for the page or section
number.

Click the Type menu, point to Insert
Special Character, point to
Markers, and then click Current
Page Number or Section Marker.

A special character marker
appears in the text box. The
current page or section number is
the prefix for the master page. 

For facing pages, repeat steps 3-5
for the other page.

6

5

4

3

2

1

One of the most common elements added to a master page is a page
number. InDesign uses a special character to designate page numbers.
On a master page, simply create a text box, place the insertion point in
the box, and then insert the current page number marker. You can also
insert and format additional text and variables in the text box to create
a header or footer across the top or bottom of the page. You can also
use the Numbering & Section Options dialog box to change the format
of page numbers or the starting page number. If you want to insert text
before the page number, you can specify a section prefix. In addition to
page numbers, you can also define a section within a document with
separate numbering. A section indicator icon (black triangle) appears
above the page thumbnail in the Pages panel.

ID 2.1, 2.11

1

2

3

4 5
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Set Page Numbering and
Section Options

Select the Pages panel.

Double-click the page where you
want to start the page numbering
or section to start.

Click the Layout menu, and then
click Numbering & Section
Options.

Select the Start Section check box
to start a new section.

Click the Automatic Page
Numbering or Start Page
Numbering At option.

If you selected the Start Page
Numbering At option, specify the
following options:

◆ Section Prefix. Enter a prefix
that will appear before the
page number, if desired.

◆ Style. Select a style for the
page number.

◆ Section Marker. Enter text,
such as Section, for a section
within a document.

◆ Include Prefix When
Numbering Pages. Select this
option if you want to add the
section prefix to the page
number.

Click OK.

A section indicator icon (black
triangle) appears above the page
thumbnail in the Pages panel.

Double-click the page where you
want the section to end, and then
repeat steps 3-7 for section
numbering (except, in this case,
you will need to deselect the Start
Section check box). 

8

7

6

5

4

3

2

1

74 5

6
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Working with Chapter
Numbers

Add a Chapter Number to a
Document

Select the Pages panel.

◆ You can also click the Window
menu, and then click Pages.

Double-click the page or master
page where you want to place a
chapter number.

Select the Type tool on the Tools
panel.

Click where you want to create a
text box for the chapter number.

Click the Type menu, point to Text
Variables, point to Insert Variable,
and then click Chapter Number.

5

4

3

2

1

Like page numbers, you can insert chapter numbers into documents
that will be part of a book. Unlike a page number, a chapter number is a
predefined text variable. The chapter number variable can be updated
automatically and formatted as text. To insert a chapter number vari-
able, create a text box, place the insertion point in the box, and then
insert the variable using the Text Variable submenu on the Type menu.
You can use the Numbering & Section Options dialog box to change
updating options for chapter numbers.

ID 6.5
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Set Chapter Numbering Options

Select the Pages panel.

Double-click the page where you
want to start the chapter
numbering.

Click the Layout menu, and then
click Numbering & Section
Options.

Click the Style list arrow, and then
select a chapter numbering style.

Select one of the following
options:

◆ Automatic Chapter Numbering.

◆ Start Chapter Numbering At.
Enter a starting chapter
number.

◆ Same as Previous Document in
the Book.

Click OK.6

5

4

3

2
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Creating and Using
Text Variables

Define a Text Variable

To define text variables for all
documents, close all open
documents. Otherwise, the text
variable is only available for the
current document.

Click the Type menu, point to Text
Variables, and then click Define.

Click New, or select an existing
variable, and then click Edit.

Type a name for the variable.

Click the Type list arrow, and then
select a variable type.

Specify the options you want for
the selected variable type. 

Options vary; some of the common
options include:

◆ Text Before or Text After. Insert
text to add before or after the
text variable.

◆ Style. Select a style for the
selected variable type.

Click OK.7

6

5

4

3

2

1

A text variable is an element that varies based on circumstances in the
document. You can use one of the preset text variables that comes with
InDesign or you can create your own. Some of the preset variables
include Running Header and Chapter Number. These are useful for
adding information to master pages. Other variables, such as Creation
Date, Modification Date, Output Date, and File Name, are useful for
adding file information to the slug area for printing. To use a text vari-
able, simply create a text box, place the insertion point in the box, and
then insert the variable using the Text Variable submenu on the Type
menu. You can also insert and format additional text along with the
Running Header variable in the text box to create a header or footer
across the top or bottom of the page on a document or master page. 

ID 2.11, 6.2, 6.5

New Text Variable
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Work with Text Variables 

◆ Insert Text Variables. Click to
place the insertion point where
you want the text variable (on a
document or master page), click
the Type menu, point to Text
Variables, point to Insert Variable,
and then select a variable.

◆ Delete Text Variables. Click the
Type menu, point to Text Variables,
click Define, select the variable,
and then click Delete.

◆ Convert Text Variables to Text.
Select the text variable in the
document, click the Type menu,
point to Text Variables, and then
click Convert Variable to Text.

◆ To convert all instances of the
text variable, click the Type
menu, point to Text Variables,
click Define, select the
variable, and then click Convert
To Text.

◆ Import Text Variables from
Another Document. Click the Type
menu, point to Text Variables,
click Define, click Load, double-
click the document with the
variables, select the variables that
you want in the Load Text
Variables dialog box, and then
click OK.

Variables

Buttons to work
with variables

Text variables
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Creating a Book

Create a New Book

Click the File menu, point to New,
and then click Book.

Enter a name for the book file.

Navigate to the drive or folder
location where you want to save
the book. 

Click Save.

The tab for the Book panel
displays the name of the book.

Open an Existing Book

Click the File menu, and then click
Open.

Navigate to the drive or folder
location where the book you want
to open is stored.

Select the book you want to open.

Click Open.

The Book panel opens.

4

3

2

1

4

3

2

1

Instead of creating long InDesign documents, you can break them up
into smaller documents, like chapters, and then create a book to bring
them all together. A book is not a document. It simply keeps track of all
the documents in the book and coordinates document page numbers,
colors, and styles. When you create a new book or open an existing
book, the Book panel appears, displaying the book name in the title tab.
In the Book panel, you can add, remove, move, or open documents.

ID 6.2
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Add, Remove, Move, or Open
Documents in a Book

Open the book you want to edit.

Do any of the following: 

◆ Add a Document. Click the Add
Document button on the panel,
locate the document you want
to add, and then click Open.

◆ Remove a Document. Select a
document in the Book panel,
and then click the Remove
Document button at the bottom
of the panel.

◆ Move a Document. Drag a
document to a new position in
the Book panel. 

◆ Open a Document. Double-click
a document in the Book panel.
An open book icon appears,
indicating the book is open. 

Click the Save Book button on the
panel.

Click the Close button to close the
book.

4

3

2

1

Did You Know?
You can replace a document in a book.
Open the book, select the document
that you want to replace, click the
Options menu, click Replace
Document, select the replacement file,
and then click Open. 

You can print an entire book. Open the
book, and then click the Print Book
button on the panel.

1

2

Open a document

Move a document

3

4
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Managing Books

Synchronize Books

◆ Synchronize Options. Open the
book, click the Options menu, click
Synchronize Options, select the
options you want to synchronize,
and then click OK.

◆ Set Style Source. Open the book,
and then click the Style Source
box next to the name of the
document.

◆ Synchronize Style Source for a
Book. Open the book, click the
Synchronize Book button on the
panel.

◆ Synchronize Style Source for a
Document. Open the book, select
the document, click the Options
menu, and then click Synchronize
Selected Documents.

When you create a book, you can synchronize page numbers, colors,
and styles for all the documents in the book. Each book uses a file
called the style source to control the style sheets (including character,
paragraph, table, and object styles), swatches, conditional text, num-
bered lists, text variables, and master pages for all the documents in
the book. When you make changes to the style source file, all or
selected documents in the book are synchronized to the file. You can
set synchronizing options to specify the features that you want to keep
up-to-date in the Synchronize Options dialog box. With the Smart
Match Style Groups synchronize option, you can synchronize a book
without creating duplicate styles (New!) . 

Did You Know?
You can set page numbers for each
document in a book. Open the book,
click the Options menu, click
Document Numbering Options, specify
the options you want, and then click
OK. See “Working with Page
Numbers,” on page 71 for details about
the page numbering options. 

ID 6.2

Synchronize options

Style source Click to synchronize styles and
swatches with the Style Source
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Set Page Numbering Options 
in a Book

Open the book you want to
change.

Click the Options menu, and then
click Book Page Numbering
Options.

Select one of the following Page
Order options:

◆ Continue from previous
document. Starts new pages in
sequence.

◆ Continue on next odd page.
Starts new pages on an odd
number.

◆ Continue on next even page.
Starts new pages on an even
number.

Select any of the following
options:

◆ Insert Blank Page. Select to
insert a blank page when using
odd or even page numbers.

◆ Automatically Update Page &
Section Numbers. Select to
automatically adjust page
numbers in book documents.

Click OK.

To update numbering in a book,
click the Options menu, choose
Update Numbering, and then click
any of the following:

◆ Update Page & Section
Numbers.

◆ Update Chapter & Paragraph
Numbers.

◆ Update All Numbers.

6
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Creating a Table of
Contents

Prepare for and Create a Table
of Contents

To prepare for creating a table of
contents, do the following:

◆ Add Page for TOC. Add a page
for the table of contents.

◆ Add Paragraph Styles. Apply
different paragraph styles to
the text that you want to use in
the table of contents.

Click the Layout menu, and then
click Table of Contents.

Enter text for the title of the table
of contents, and then use the
Styles menu to select a style for
the title text.

Select the paragraph styles that
are applied to text in your
document (under Other Styles),
and then click Add to include them
in the other list (under Include
Paragraph Styles).

◆ To remove a style, select it
(under Include Paragraph
Styles), and then click Remove.

To format an entry in the table of
contents, select the entry (under
Include Paragraph Styles), click
the Entry Style list arrow, and then
select a style.

5

4

3

2

1

A table of contents (TOC) appears at the beginning of a document, typi-
cally a long one, with page numbers associated with the beginning of
main sections of the document. InDesign creates a table of contents
based on the styles applied to paragraphs in the document. The table of
content displays the text and page number associated with the para-
graph styles. For example, when you apply different styles for chapter
and topic titles in this book, you create a table of contents based on
chapters and topics. So, before you can create a table of contents, you
need to apply paragraph styles to text in your document.

ID 6.3, 7.3
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Click More Options to display
additional options.

Select any of the following
advanced options:

◆ Page Number. Select a position
for the entry’s page number.

◆ Between Entry and Number.
Select a separator character
between the entry and the
number.

◆ Sort Entries in Alphabetical
Order. Select to alphabetize the
table of contents.

◆ Level. Select an indent level for
each entry in the table of
contents.

Select any of the following
options:

◆ Create PDF Bookmarks. Select
to add bookmarks to the PDF
created from the table of
contents.

◆ Replace Existing Table of
Contents. Select to update or
change the table of contents.

◆ Include Book Documents.
Select to create a table of
contents of all the documents
in a book.

◆ Numbered Paragraphs. Select
to format how paragraphs with
auto numbering are formatted.

◆ Run-In. Select to create a
single paragraph table of
contents with each entry
separated by a semicolon (;)
and a space.

◆ Include Text on Hidden Layers.
Select to use hidden text on
layers.

Click OK.9

8

7
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Adjusting Layouts

Change Layout Adjustment
Options

Click the Layout menu, and then
click Layout Adjustment.

Select the Enable Layout
Adjustment check box.

Select from the following options:

◆ Snap Zone. Enter a distance
value for snapping an object to
a margin, column guide, or
page boundary.

◆ Allow Graphics and Groups to
Resize. Select to allow
graphics and groups to resize
during the adjustment.

◆ Allow Ruler Guides to Move.
Select to allow ruler guides to
move during the adjustment.

◆ Ignore Ruler Guide Alignments.
Select to keep objects from
moving along ruler guides
during the adjustment.

◆ Ignore Object and Layer Locks.
Select to move locked objects
and layers during the
adjustment.

Click OK.4

3

2

1

If you ever need to change the page size or margins after you have
already added a document page or created a master page, you can
enable the Layout Adjustment option to have InDesign adjust the layout
and position of elements on document and master pages. The Layout
Adjustment dialog box allows you to enable the option and set other
related adjustment options, such as Allow Graphics and Groups to
Resize and Ignore Object and Layer Locks. 

See Also
See “Setting Up a Document” on
pages 34-35 for more information on
changing the document page size and
margins.

2 4
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Index

A
absolute colorimetric, specifying, 191
Acrobat layers, Adobe PDF option for creat-

ing, 365
actions for buttons, editing or adding,

336–337
activation of program, 2
Actual Size, viewing document in, 38
Add button, Pathfinder, 247
additive RGB. See RGB (Red, Green, Blue)
Adobe

Acrobat, 365
Creative Suite, 1, 442
Dreamweaver, exporting documents for,

378–379
exploring programs, 442
Fireworks, accessing Kuler panel with,

208
Product Improvement Program, 23
programs working with, 441–45?
web site

plug-ins, availability of, 429
updates and patches, checking for, 20
Welcome screen links to, 4

Adobe Bridge, 1, 442
automating tasks in, 452
Batch command in, 450
browsing

documents, 14
graphics, 134

color settings synchronizing, 189
copying and pasting settings in, 450
digital cameras preferences for Camera

RAW, 446
DNG format, converting RAW files to,

445
documents, inserting file information in,

402–403

getting started with, 444
Home web site, 4
Image Processor command in, 450
images, working with, 448–449
JPEG files, opening, 446
labels to images, adding, 449
libraries, using, 343
linked graphics, locating, 134
modifying images in, 450
naming/renaming, 14

automatically renaming files, 452
opening

documents in, 12, 14–15
graphics, 134

preferences
camera raw files, 446

presets, applying, 450
previewing, 448–449
raw images

importing, 445
modifying, 447, 450
working with, 446–447

renaming files automatically in, 452
revealing documents in, 15
screen, diagram of, 443
searching in, 14, 448
templates, accessing and selecting, 30
thumbnails in, 448–449
TIFF files, opening, 446
Tools menu, automating tasks with, 452
Web Photo Gallery, creating, 451
working with files in, 15
workspaces, 443

customizing, 444
XMP files in, 449

Adobe ConnectNow, 442
Share My Screen command, 453
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Adobe Device Central, 1, 442
checking content using, 457
screen, exploring, 456
Tools menu in Adobe Bridge for starting,

452
Adobe Drive, 442

working with, 455
Adobe Extension Manager, 1, 442

working with, 458
Adobe Flash, 360. See also SWF file format

buttons in, 333
export file formats, 361
Flash movie, exporting document as,

374–375
Kuler panel, accessing, 208
page transitions in, 332
XFL for Flash, exporting document as,

376–377
Adobe Illustrator

importing artwork from, 129, 130–131
Kuler panel, accessing, 208
placing graphic files saved in, 128
specialty frames for graphics, importing,

142
Adobe InCopy, 432. See also assignments

assignment files, creating, 434
color of user, setting up, 433
InDesign content, exporting, 434
managed files, 432, 434

notes, adding, 433
Package for, 436
screen, diagram of, 440
updating content in, 439
user identification, setting up, 433
working with, 440

Adobe InCopy CS3 Interchange, 361
Adobe InCopy Document, 361
Adobe InDesign CS3

file format, 12
Interchange (INX), 361

Adobe InDesign CS4
installing, 2–3
system requirements, 3
tagged text, 361
window, viewing, 6

Adobe InDesign Markup (IDML) file format,
12, 361

Adobe InDesign Template (INDT) file format,
30. See also templates

Adobe PDF. See PDF file format
Adobe Photoshop

Adobe Bridge, using commands in, 450
automating tasks in, 452
Batch command in Adobe Bridge, 450
clipping paths, creating, 250
Image Processor command in Adobe

Bridge, 450
importing images, selecting layers

when, 129, 130–131
Kuler panel, accessing, 208
placing graphic files saved in, 128
wrapping text, path for, 123

Adobe Updater Preferences dialog box,
20–21

Adobe Version Cue, 1, 442
Adobe Bridge and, 444
Adobe Drive with, 455
managing files with, 454
XMP files in, 449

After-Blending Intent option, 190
AICB (Adobe Illustrator Clipboard), 142
Align and Distribute, 11
aligning. See also grids; Smart Guides

bullets and numbering, 115
objects, 166
paragraphs, 109
stroke on path, changing alignment of,

216
table cells, content of, 265
tabs, 116
text frame options, setting, 120
text on a path, 89
Type tool option, 11

All Caps, styling text as, 102–103
alpha channels

clipping path, selecting as, 251
importing images with, 129, 130–131
for wrapping text, 123

anchor points
adding, 238–239
deleting, 239
Direct Selection tool, selecting with, 159
joining, 242
moving, 236
open path, adding to, 239
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with Pen tool, 234–235
reshaping, 236
selecting, 236
Smooth tool, using, 243
splitting paths at, 240

anchors
hyperlinks creating text anchors, 322
for objects, 177

ANPA color library, 202
anti-aliasing in Story Editor display, 422,

423
appearance

Adobe InCopy, Appearance panel in, 440
Black, preferences for appearance of, 421
of conditional text, 350
of graphic frames, 154
hyperlinks, changing appearance of, 325
ruler guides, changing appearance of,

44–45
AppleScripts, 352
Application bar, 6

in Adobe InCopy, 440
Apply Effect, 11
Apply Photoshop Clipping Path Option, 250
Arial font, 102
Arrange Documents menu, 18–19
artboards, importing, 129, 130–131
artwork. See graphics
assignments

checking content out and in, 438
creating, 436–437
existing assignment, adding to, 437
locked files, overriding, 439
out-of-date content, checking for, 439
packages, creating, 436
same time, creating assignment and

adding content at, 436–437
updating content, 439

Assignments panel, 435. See also assign-
ments

Assign Profile dialog box, 190–191
audio, 330–331
Autocorrect for text, 100
autoflowing imported text, 93

B
backgrounds

guides in, 44

Smart Guides in back, showing, 47
Story Editor display, setting, 422

base color, 203
baseline

characters, shifting, 105
for footnotes, 315
paragraph rule, setting for, 113
paragraphs to baseline, aligning, 109
printing options, 384
table sells, specifying option for, 265
for text frames, 121

baseline grids, 48
preferences, setting, 49

Basic Feather effect, 229
Batch command in Adobe Bridge, 14, 450
bevel effect, 228

with corner options, 230
rectangles, beveled, 231
strokes, bevel join on, 217

bibliographies, hanging indents for, 110
bicubic downsampling with Adobe PDF, 366
bitmaps

BMP file format, placing graphic files
saved in, 128

color profiles for, 190–191
fonts, creating, 104
print as bitmap option, 394

black. See also CMYK (Cyan, Magenta,
Yellow, Black)

tones, preferences for, 421
blank pages, printing, 384
bleed. See marks and bleed
Bleed view, 36
blend effect, creating, 224–225
blending mode

color space, selecting, 225
feather effects, 229
glow effects, 227
with shadow effects, 226

BMP file format, placing graphic files saved
in, 128

boldfacing, changing, 102
bookmarks

Adobe PDF option, 365
creating, 328–329

Bookmarks panel, 329



482

books
adding or deleting, 77
blank page, inserting, 79
eBook, exporting document for, 378
existing book, opening, 76
new book, creating, 76
opening documents in, 77
Page Order options, 79
printing, 77
saving, 77
synchronizing, 78
updating page and section numbers in,

79
Books template, 30
Book workspace, 52–53
borders to tables, adding, 273
Bounding Box option, 122–123
Bridge. See Adobe Bridge
Bring Forward in object stack, 168
Bring to Front in object stack, 168
Brochures template, 30
browsing. See also Adobe Bridge

Kuler panel themes, 208
bullets and numbering

adding, 114
Adobe Dreamweaver, exporting docu-

ment for, 379
digital editions, specifying options for,

378
formatting, 115
paragraph styles, setting, 279

butt caps on strokes, 217
buttons

actions, adding or editing, 336–337
Buttons panel, working with, 333
button states, working with, 338
deleting, 333
events for button, setting, 336
objects to buttons, converting, 334–335
sample, creating from, 334
tab order, setting, 339

Buttons panel, 333

C
camera raw images. See Adobe Bridge;

DNG file format
Canon CR2 format, 447
cap colors for paragraph rule, width of, 112

capitalization. See also case-sensitivity;
drop caps; small caps

Autocorrect fixing, 100
changing case, 312
hyphenating capitalized words, 309
spell-checking preferences, 418

caps on strokes, changing, 216–217
case-sensitivity

Adobe PDF passwords, 370
changing case, 312
with Find/Change command, 305
of style names, 284

Catalogs template, 30
CD/DVD

contents of, 2
sets template, 30

Cell Options dialog box, Diagonal Lines tab,
272

cell phones and RGB color, 192
cells. See tables
centering

paragraphs, 109
with Smart Guides, 47
text on path, 89

Certificates template, 30
chapter numbers

adding to document, 72
text variable, 74

Character panel, InCopy, 440
characters. See also letters

advanced type settings for, 412
for bullets, 114–115
End Nested Style Here special character,

288–289
Find/Change command for, 304
Info panel, information in, 50
for leading text, 105
outlines, creating, 124
for page numbers, 70
spacing options, 311
special characters

Find/Change command for, 304
inserting, 118

character styles
attributes for, 281
creating, 280–281
deleting, 280
nested styles, creating, 288–289
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Character Styles panel, 276
check boxes, 114–115
Chinese typefaces, 412
Chisel Hard option with bevel effect, 228
Choke effect

with feather effects, 229
with glow, 227
with shadows, 226

Classic System theme, 422
Clear Transformation command, 169
Clipboard

handling preferences, setting, 426
objects, copying, 162

Clip Content to Cell option, 265
clipping path

alpha path as clipping path, selecting,
251

editing on importing, 131
graphic, modifying from, 131, 250
importing images with, 129, 130–131
for wrapping text, 123

Close button, 18, 26
for panels, 8

closed path, opening, 240–241
closing documents, 26
CMYK (Cyan, Magenta, Yellow, Black), 192

Adobe PDF options, setting, 368
black tones, preferences for, 421
Color panel, selecting with, 196
EPS file format options, 372
preserving colors, 211
Working Space controls, 188–189

Collapse to Icons option for panels, 8
collapsing/expanding. See panels
Color blend mode, 224
Color guide panel, 214
Color Management, 188–189

printing options, 396
color modes, 192

Color panel, selecting with, 196
Color panel, 156

fill or stroke color, changing, 214
selecting color modes with, 196
working with, 197

Color Picker, 214, 215
color profiles

for bitmap images, 190–191
changing, 190–191

deleting, 190–191
document colors to other profile, con-

verting, 190–191
importing images with, 129, 130–131
Info panel, information in, 50
rendering intent, specifying, 191

colors. See also CMYK (Cyan, Magenta,
Yellow, Black); color profiles; fills; gap
color/tint; gradients; Lab color; marks
and bleed; objects; paragraphs; print-
ing; RGB (Red, Green, Blue); strokes;
Swatches panel; tables

Adobe InCopy, setting colors for, 433
Adobe PDF output options, 368
applying colors, 193
assignments, association with, 436
for baseline grids, 49
blend effect, creating, 224–225
for buttons, 338
of camera raw images, 447
changing settings, 188–189
character styles, setting, 281
for commands, 428
for conditional text, 350
for cross-references, 326
dashed/dotted lines, gap color for, 217
for Document grids, 49
EPS file format options, 372
Eyedropper tool, using, 194–195
frame for graphic, coloring, 149
gradient swatches, creating, 204–205
for guides, 44
hidden text, changing colors of, 119
for hyperlinks, 325
Kuler panel, using colors from, 208–209
layer colors, specifying, 180
note colors, identifying, 317
overprinting colors, 210
for package files, 404
proofing colors on screen, 211
separations, previewing, 389
soft proofing colors on screen, 211
swatch libraries, adding colors from, 202
synchronizing color settings, 189
for text in Story Editor display, 422
tint swatches, creating, 203
for Web Photo Gallery, 451

Color Sampler tool with camera raw files,
447
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Color Settings dialog box, 188–189
color space

for blending transparent objects, 225
Info panel, information in, 50

color stops
editing, 221
with gradients, 204–205

columns and rows. See also guides; tables
changing options, 34–35
for Data Merge, 354
hyphenating across, 309
for new documents, 29
text frame options, setting, 120

Command Bar for InCopy, 440
commands, 6

Adobe InCopy commands, 440
Batch command in Adobe Bridge, 14,

450
Community Help site, 22
Community resources, Welcome screen

links to, 4
compatibility

Adobe PDF options, setting, 364
of assignments, 436

composition preferences, setting, 413
compound path, creating, 248–249
compression

Adobe PDF options, 363, 366
Flash movie, document exported as, 375

condensed style, changing, 102
conditional text, working with, 350–351
Conditional Text panel, 351
Configure Plug-ins dialog box, 429
configuring plug-ins, 429
ConnectNow. See Adobe ConnectNow
consolidating all documents, 19
contact sheet, creating, 132–133
continued text, adding page numbers to,

125
Control of Transform panel, 169, 170
Control panel, 6, 156

Adobe Bridge, 443
Customizing, 430
resizing objects in, 160
using, 11

Convert Direction Point Tool, 237
copies

printing option, 384

saving copy of document, 25
Copyfit Info panel, Adobe InCopy, 440
copying. See also objects

Adobe Bridge, settings in, 450
Clipboard handling preferences, setting,

426
master pages, 69
paths, 143
text, 101

corner object effects, 230
Corner Options dialog box, 230

rectangle shapes using radius value in,
231

Create Outlines command, 124, 142–143
creep for booklet pages, 399
cropping

Adobe PDF setting options, 366
camera raw files, 447
fitting graphics in frames and, 147

Cross-Reference dialog box, 327
cross-references, creating, 326–327
CSS styles

Adobe Dreamweaver, exporting docu-
ment for, 379

for eBook, 378
CSV (comma-delimited) data fields, 354
cursors

graphic preview cursor, 132
Story Editor cursor options, setting, 423

curves, Pen tool for drawing, 234–235
custom-dashed stroke, applying, 218
custom page size, 29
cutting

spacing, automatic adjustment of, 410
text, 101

D
Darken blend mode, 224
dashes. See also strokes

inserting, 118
Data Merge, 354–355

template, 30
DCS file format, WMFgraphic files saved in,

128
Default Image Intent option, 190–191
Delete Workspace dialog box, 53
deleting. See also tables
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with Adobe Bridge, 14
Adobe PDF preset, creating, 371
anchor points, 239
bookmarks, 329
books, documents in, 77
buttons, 333
button states, 338
character styles, 280
color profiles, 190–191
color swatch, 199, 200
combined object, 165
cross-references, 327
empty pages, 96, 411
guides, 43
hyperlinks, 321, 324
layers, 179
library items, 342–343
master pages, 68–69
moving, deleting pages after, 63
notes, 317
objects, 157
in Open dialog box, 13
pages in Pages panel, 62
paragraph styles, 278
plug-ins, 429
presets, 32–33, 383
in Save As dialog box, 13
script files, 352
segments, 239
styles, 293
tabs, 116
text on path, 88
text variables, 75
trap presets, 392
workspaces, 53
XML tags, 356

destination files
Adobe PDF options, setting, 368
for cross-references, 327
for hyperlinks, 320
for linked graphics, 137

detect edges and wrapping text, 123
Device Profiles tab, Device Central, 456
Device Sets panel, Device Central, 456
diagonal lines in table cells, adding, 272
Diagonal Lines tab, Cell Options dialog box,

272

DIC color library, 202
dictionaries

Autocorrect dictionary, 100
custom dictionaries, using, 300
preferences, setting, 416–417

digital cameras. See also Adobe Bridge
documents, inserting file information in,

402–403
digital editions, exporting documents for,

378–379
Digital Imaging and Communications in

Medicine options, inserting, 403
Directional Feather effect, 229
Direct Selection tool. See also overflow text

anchor points, selecting, 159
frames and graphics, selecting and mov-

ing, 144
graphics, selecting, 144, 158
grayscale graphic, applying color to, 149
with grouped objects, 164–165
objects, selecting, 157, 159

display
changing, 36
library display, changing, 346–347
output views, 36–37
Story Editor display preferences, setting,

299, 422–423
Distribute Columns Evenly command, 262
Distribute Rows Evenly command, 262
distributing

columns, 262
objects, 166–167

DNG file format
converting raw images to, 445
description of, 447
saving raw images in, 446

docking/undocking
document windows, 19
panels, 8

Document grids, 48, 49
Document Presets dialog box, 32
documents. See also assignments; books;

exporting documents; graphics;
Microsoft Word; multiple documents;
new documents; opening

Adobe Bridge, working with, 14
changing document options, 34
closing, 26
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documents (continued)
color profiles, converting, 190–191
display performance, setting, 151
file information, inserting, 402–403
images, inserting, 16
object defaults, setting, 232
preview images with document, saving,

24–25
printing, 382
saving, 24–25
spell-checking, 298–299
swatches from other documents, import-

ing, 202
tabs, open as, 409
text, inserting, 16
XML tags, placing, 356–357
zooming in/out view of, 38–39

Document Setup dialog box, 34
document windows, 6

for Adobe InCopy, 440
docking/undocking, 19
working with, 18

double quotation marks, inserting, 118
downloading

extensions with Adobe Extension
Manager, 458

print option for downloading fonts, 388
downsampling with Adobe PDF, 366
drag-and-drop

graphics, 136
pages, moving, 62–63
paths, 143
snippets, creating, 348–349
text, 101
text editing options, selecting, 411
with Zoom tool, 38

drop caps
creating, 111
paragraph styles, setting, 279

Drop Shadow, 11, 226
DTBook format for eBooks, selecting, 378
duplicating

color stops, 221
color swatch, 198
layers, 178–179
objects, 162–163
pages, 58

plug-ins, 429
DVD. See CD/DVD
dynamic spelling, 298, 299, 419

E
eBook, exporting document for, 378–379
Edit Custom Dictionary dialog box, 300
editing. See also hyperlinks; Story Editor;

text
Adobe PDF editing preset, creating, 371
button actions, 336
clipping path on importing, 131
color swatch, 199
cross-reference formats, 327
gradients, 220–221
Kuler panel theme, 209
linked graphics, 139, 140
mixed ink groups, 207
presets, 383
Quick Apply, styles with, 295
scripts, 352
Spread view content, 37
styles with Quick Apply, 295
tables, text in, 258–259

Edit With submenu, 140
effects. See also specific effects

for text on a path, 89
elements in XML file format, 356
Ellipse Frame tool, 154
ellipses

converting, 231
creating elliptical shape, 154

Ellipse tool, 154
text, adding, 84, 86

e-mail, hyperlinks to, 322
embedding

Adobe PDF options, 365
general preferences, setting, 408
graphics, 136, 137
preflight profiles, 400–401

emboss effect, 228
em dashes, inserting, 118
empty pages, deleting, 96, 411
empty sounds or movie clip frames, creat-

ing, 330
Emulator tab, Adobe Device Central, 456
enabling/disabling



Index 487

JavaScript, 408
Live Preflight, 400–401

en dashes, inserting, 118
End Nested Style Here special character,

288–289
endnotes. See footnotes
English typefaces, 412
envelopes with Data Merge, 354–355
EPS file format, 361

exporting document in, 372–373
inserting files in, 16
metadata to files, adding, 403
placing graphic files saved in, 128

EPUB format for eBooks, selecting, 378
erasing parts of paths, 246
errors. See also spell-checking

Preflight panel, options in, 401
Essentials workspace, 52–53
events for buttons, setting, 336
Excel. See also XLS file format

tables, importing, 256–257
Exclude Overlap button, Pathfinder, 247
EXIF file format for metadata, 449
existing document, opening, 12
Exit command, 26
exiting InDesign, 26
Expand Panels button, 8
exporting. See exporting documents;

importing/exporting
exporting documents, 360. See also PDF file

format
for Adobe Dreamweaver, 378–379
description of file formats, 361
for digital editions, 378–379
in EPS file format, 372–373
as JPEG files, 380
XFL for Flash, exporting document as,

376–377
Export PDF dialog box, 332
Extension Manager. See Adobe Extension

Manager
Extensions submenu for accessing Kuler

panel, 208
Eyedropper tool

colors, using for, 194–195
fill or stroke color, changing, 214
options, changing, 195

F
facing pages

changing, 34
new documents, selecting for, 28
spreads, preserving, 411

Fancy corner options, 230
Favorites panel, Adobe Bridge, 443
feather effects, 229
fields for Data Merge, 354
file formats. See also exporting documents;

specific types
opening document files in, 12
placing graphic files saved in, 128

File path, Adobe Bridge, 443
files. See also Adobe InCopy; Adobe

Version Cue; assignments
documents, inserting file information in,

402–403
handling preferences, setting, 424–425
hyperlinks to, 322
package files, creating, 404–405
sidecar files, 449

fills. See also tables
adding, 268–269
applying fill colors, 193, 214–215
compound path, object's fill in, 249
default and switch for fill colors, 214–215
defaults, setting, 232
Eyedropper tool, using, 194–195

Filter panel, Adobe Bridge, 443
filters

with Adobe Bridge, 14, 443
Graduated Filter with camera raw files,

447
Find/Change command, 302–303

for glyphs, 302–303, 306
for GREPs, 302–303, 306
with objects, 302–303, 308
special characters, finding, 304

Find Font dialog box, 301
first-line indent

for bullets and numbering, 115
creating, 110

first page, navigating to, 61
Fit Page In Window option, 38
Fit Spread in Window option, 38
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fitting
booklet pages, marks and bleed in, 399
Flash movie, document exported as, 374
graphics in frames, 147
XFL for Flash, document exported as,

376
Flash. See Adobe Flash
flattened artwork, printing, 395
Flattener Preview mode, 36–37
flatten transparency. See transparency
flipping, 11. See also objects

print orientation, 391
text on a path, 89

floating all windows, 19
floating tools panel options, 409
Focoltone color library, 202
Folders panel, Adobe Bridge, 443
folders with Adobe Bridge, 14
Font Family option, Type tool, 11
fonts. See also glyphs; OpenType

Adobe PDF options, setting, 369
changing, 301

font family and style, 102
size of font, 104

digital editions, specifying options for,
378

Find/Change command, using, 302–303
finding fonts, 301
general preferences, setting, 408
graphics, options for, 388
package files including, 404–405
preferences, setting, 410–411
preview size, selecting, 411
printing options, 394
size of font, changing, 104
Story Editor display, setting, 422
styles, changing, 102–103

Font Size option, Type tool, 11
Font Type option, Type tool, 11
Footnote Options dialog box, 314
footnotes

adding, 314
changing options, 315
Find/Change command for searching,

303
importing, 314

foreign characters, printing, 387
formatting. See also styles

bullets and numbering, 115
dragged text, inherited formatting for,

101
footnotes, 315
frames, graphics in, 149
graphics in frames, 149
JPEG files, documents exported as, 380
table of contents, 80–81

form letters with Data Merge, 354–355
Forms template, 30
45-degrees

lines, drawing, 156
objects, constraining movement of, 161

fractions. See glyphs
Frame Fitting Options dialog box, 146–147
frames. See graphic frames; text frames;

unassigned frames
Frame tools for adding text, 84, 86
Free Transform tool, 170
French typefaces, 412
Fuji RAF format, 447

G
Gallery & Story panel, InCopy, 440
gamut colors. See also out of gamut

identifying, 197
gap color/tint. See also tables

for dashed/dotted lines, 217
paragraph rule, width of, 112

general preferences, setting, 408
Get Photos from Camera command, Adobe

Bridge, 445
Getting Started, Welcome screen links to, 4
GIF file format

metadata to files, adding, 403
placing graphic files saved in, 128
WMFgraphic files saved in, 128

Global Light effect, 226
with bevel effect, 226
with emboss effect, 226
setting, 228
with shadows, 226

glow effects, 227
glyphs

Find/Change command, using, 302–303,
307

highlighting text with, 413
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inserting or replacing, 117
spacing options, 311

Go Back option, 61
Go Forward option, 61
Go to Page option, 61
GPS (global positioning system) file format

for metadata, 449
Gradient Feather tool, 223, 229
Gradient panel, 205. See also gradients
gradients. See also color stops

applying gradient fill to object, 220
editing, 220–221
Gradient Feather tool, 223, 229
Gradient tool, working with, 222
swatches, creating, 204–205

Gradient tool, 222
Graduated Filter with camera raw files, 447
graphic frames. See also assignments

appearance of, 154
for bookmarks, 328
clipping path to frame, converting, 131,

250
coloring graphic frame, 149
compound path as frame, creating and

releasing, 142
fitting graphics in, 146–147
formatting graphics in, 149
Frame Fitting Options dialog box, fitting

graphics in frames with, 146–147
grayscale graphic, coloring, 149
moving frames and graphics, 144–145
nesting graphics in, 148
resizing, 145

for fitting graphics in frames, 146
graphics and frames, 145

searching for, 308
selecting frames and graphics, 144–145
specialty frames for graphics, creating,

142–143
type outlines as frames, creating, 143

graphic preview cursor, 132
graphics, 128. See also Adobe Photoshop;

graphic frames; tables
Adobe Bridge, placing graphics from,

134–135
clipping path, modifying, 250
contact sheet, creating, 132–133
copying, 136
default display options, setting, 151

Direct Selection tool, selecting with, 144,
158

display
changing display performance, 150
default display options, setting, 151

documents
file information, inserting, 402–403
images, inserting, 16

drag-and-drop, 136
editing linked graphics, 139, 140
embedding, 136, 137

changing graphic from linked to
embedded, 139

existing frame with graphic, placing
graphic in, 128

grayscale graphic, coloring, 149
high quality display, 150
InCopy, exporting content to, 434
Info panel, information in, 50
Info panel, viewing in, 51
inline graphic in object, placing, 176
linked graphics

Adobe bridge, locating in, 134
displaying information on, 137
editing, 139, 140
relinking, 137, 138, 139
replacing, 138
working with, 139
XMP metadata, displaying, 141

locating graphics
Adobe bridge, locating linked graphic

in, 134
Links panel, 138

moving, 136
multiple graphics, placing, 132–133
nesting graphics in frames, 148
options, placing graphics with, 129
package files including, 404–405
pasting, 136
preview cursor, 132
print options, setting, 388
relinking, 138

missing graphic, 137, 139
replacing linked graphic, 138
resizing, 145

allowing for, 82
with Direct Selection tool, 158
for fitting graphics in frames, 146
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graphics (continued)
setting place import options, 130–131
sorting graphics in Links panel, 137
typical display setting, 150
updating links, 139
XMP metadata, displaying, 141
zooming in/out view of, 38–39

grayscale
with camera raw images, 447
EPS file format options, 372
graphics in grayscale, adding color to,

149
greeked text, 411
GREPs

applying, 286–287
creating, 282
Find/Change command, using, 302–303,

306
paragraph styles, setting, 279
searching for, 306

GREP Styles dialog box, 306
grids. See also baseline grids

Adobe PDF option, 365
colors, specifying, 49
preferences, changing, 48–49
printing options, 384
showing/hiding, 48
Step and Repeat command, creating grid

with, 163
tiling documents in, 19
working with, 48, 49

groups. See also objects
mixed ink group, creating, 207
style groups, creating, 283

guides. See also rulers; Smart Guides
Adobe PDF option, 365
changing guides, 44
columns

color, specifying, 44
locking/unlocking, 43

creating, 42
deleting, 43
moving, 42
printing options, 384
Smart Guides, 46–47
working with, 43

gutters
changing size of, 35

new documents, selecting for, 29
text frame options, setting, 120

H
Hand tool, moving with, 50
hanging indents, creating, 110
Hard Light blend mode, 224
harmony rule for colors, 209
headers and footers. See also tables

for panels, 8
height, weight, width, 11. See also tables

changing, 34
for cross-references, 326
Flash movie, document exported as, 374
for hyperlinks, 325
for new documents, 28
paragraph rule, width of, 112–113
printing setup options, 385
stroke, selecting weight of, 156, 216
text frame options, setting, 120
XFL for Flash, document exported as,

376
help information, 22–23

Adobe ConnectNow toolbar for, 453
searching for, 22–23

Help menu
help information on, 22–23
updates, checking for, 21

hidden lock files (IDLK), 438
hidden text

in table of contents, 81
working with, 119

hiding. See showing/hiding
highlights

composition preferences, setting, 413
for conditional text, 359
for cross-references, 326
for hyperlinks, 325

HKS color library, 202
horizontal lines, converting, 231
horizontally tiling all documents, 19
horizontal text, leading applied to, 105
HTML document as Flash movie, exporting,

375
hyperlinks

Adobe PDF option, 365
appearance, changing, 325
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creating, 322–323
cross-references, creating, 326–327
defining destinations, 320
deleting, 321, 324
editing, 321

from Hyperlinks panel, 325
Flash movie, document exported as, 375
resetting, 324
updating, 324
URLs

creating hyperlink from, 322–323
destination, setting URL as, 320

Hyperlinks panel, 324–325
cross-references, creating, 327

hyphenation
dictionary preferences, setting, 416
inserting hyphens, 118
options, changing, 309
in package files, 405
paragraph styles, setting, 279

Hyphenation dialog box, 309

I
ICMA files, 436
ICML files, 436
icons

for linked graphics, 137
Pages panel icons, 56–57
showing/hiding, 428

IDML file format, 12, 361
IDMS files. See snippets
Illustrator. See Adobe Illustrator
Image Processor command in Adobe

Bridge, 52
images. See graphics
Images format, inserting files in, 16
importing/exporting, 432. See also export-

ing documents; graphics; text
Adobe PDF preset, creating, 371
footnotes, 314
plug-ins, 429
presets, 383
specialty frames for graphics, 142
swatches from other documents, 202
text variables, importing, 75
XML tagged data, 356–357, 358

InCopy. See Adobe InCopy

INDD file format, 12
inserting files in, 16

indenting. See also first-line indent; para-
graphs

bullets and numbering, 115
INDL file format. See libraries
INDT file format, 30
Info panel, 50–51
Ink Manager, 391
Ink on Paper theme, 422
inks

Adobe PDF options, 368
color separations, previewing, 389
EPS file options, 373
for printing, 391

inline object, creating, 176
Inner Glow effect, 227
Inner Shadow effect, 226
Insert Anchored Object dialog box, 177
inserting. See also pages

bookmarks, insertion point for, 328
dashes, 118
tabs, 116
text variables, 75

Insert Pages dialog box, 58–59
multiple pages, inserting, 59

Inset corner options, 230
inside and outside margins. See margins
Inspector panel, Adobe Bridge, 443
installing

extensions with Adobe Extension
Manager, 458

Macintosh computers, InDesign CS4 in,
3

Windows, InDesign CS4 in, 2
interactive documents. See also buttons;

hyperlinks
Adobe PDF options, 365
Flash movie, interactivity options for,

375
Interactivity workspace, 52–53
interface preferences, setting, 409
Internet

North America Web/Internet color set-
tings, 188

updates, checking for, 20
Web color library, 202

Intersect button, Pathfinder, 247
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Inverse Rounded corner options, 230
inverted rounded rectangles, converting,

231
IPTC file format for metadata, 449
island spreads, 64
isolate blending, 224
italicizing, changing, 102

J
Japanese typefaces, 412
JavaScript
Adobe Dreamweaver, exporting document

for, 379
enabling or disabling, 408
JDF File Using Acrobat checkbox with

Adobe PDF, 369
Join or Close Path button, 242
joins on strokes, changing, 216–217
JPEG file format, 360, 361

Adobe Bridge, opening with, 446
exporting documents in, 380
importing images, options for, 129, 131
metadata to files, adding, 403
placing graphic files saved in, 128
raw images, saving, 446
as recommended compression method,

366
Jump Object option, 122–123
Jump to Next Column option, 122–123
justification

options, changing, 311
of paragraphs, 109
paragraph styles, setting, 279
table cells, content of, 265
text frame options, setting, 120

K
Keep options for paragraphs, 310
kerning, 106

highlighting text with, 413
increments preferences, setting, 414–415

keyboard increments preferences, setting,
414–415

keyboard shortcuts
defining, 427

icons for starting InDesign CS4, 4
starting InDesign CS4 with, 5
for tools, 10
zooming in/out with, 39

Keywords panel, Adobe Bridge, 443
knockout group blending, 224
Korean typefaces, 412
Kuler panel, using colors from, 208–209

L
lab color, 192

Color panel, selecting with, 196
Labels and Stickers template, 30
labels for Adobe Bridge images, 449
landscape orientation

changing, 34
for new documents, 28

languages
advanced type settings for, 412
for Autocorrect, 100

last-line indent, creating, 110
last page, navigating to, 61
last saved version, reverting to, 24
Latin typefaces, 412
Layer Options dialog box, 180
layers

Adobe InCopy, exporting content to, 434
Adobe PDF, creating Acrobat layers with,

365
colors for layers, specifying, 180
copying objects between, 184
deleting, 179
duplicating, 178–179
Find/Change command, searching locked

layers with, 303
guides, options for, 180
importing, 129, 130
locking/unlocking, 180, 182
merging layers, 183
moving objects between, 184

naming/renaming, 180
new layer, renaming, 178
new layer, creating, 178
options, setting, 180
pasting, creating new layer while, 178
printing, 180
printing options, 384
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reordering, 183, 184
selecting layers, 184
showing/hiding, 180, 181

searching hidden layers, 303
wrapping text, preventing, 180

Layers panel, showing/hiding objects and
layers in, 181

Layout Adjustment options, 82
Layout menu

pages, navigating between, 60–61
table of contents, creating, 80–81

Layout view, drag-and-drop editing in, 101
LCD Optimized display for Story Editor, 423
leading

Auto Leading option, 311
entire paragraph, applying to, 410
tabs, leaders with, 116
text, 105

left-aligning paragraphs, 109
left indents

for bullets and numbering, 115
creating, 110

left side, dragging text to, 89
lens corrections with camera raw images,

447
letters

half page size, 29
page size, 29
Quick Apply commands, 295
spacing options, 311

libraries
adding items in, 342–343
Adobe Bridge libraries, using, 343
changing item information, 345
deleting items in, 342–343
display, changing, 346–347
existing library, opening, 342
new library, creating, 342
object types for items, changing, 345
opening existing library, 342
placing items on page, 344
Samples button library, 333
searching in, 346
sorting items in, 346–347
swatch libraries, adding colors from, 202
updating items in, 344

ligatures. See glyphs

Lighten blend mode, 224
Linear gradients, 204
line breaks

balancing, 310
forcing, 98–99

lines. See strokes
Line tool, 156. See also strokes
links. See also graphics; hyperlinks

Adobe Bridge, locating linked graphics
with, 134

Adobe PDF options, 365
missing link preferences, setting, 425
in package files, 404
preferences, setting, 425
styles, breaking links to, 286

Links panel. See also graphics
sorting items in, 137

List view, displaying library items in, 347
Live Preflight, 400–401
locating graphics. See graphics
locking/unlocking

assignment files, overriding locked, 439
guides, 43
layers, 180, 182
moving locked objects, 82
object position, 175

Lock Position command, 175
lowercase text, creating, 312

M
Macintosh computers. See also PICT file

format
AppleScripts, 352
installing InDesign CS4 in, 3
starting InDesign CS4 in, 5
System color library, 202

magnification. See zooming in/out
Make Compound Path command, 248–249
managing files. See also Adobe InCopy

with Adobe Bridge, 14
margins. See also gutters

changing options, 34–35
guide color, specifying, 44
new documents, options for, 29
objects to margins, aligning, 166
optical margin adjustment, setting, 311

markers, inserting, 118
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marks and bleed
with Adobe PDF, 367
for booklet pages, 398
changing bleed values, 34
guide color, specifying, 44
for new documents, 28–29
print options, setting, 386–387

master pages
adding objects to, 66
copying, 69
deleting, 68–69
detaching, 68–69
document page, applying to, 68
existing page, creating master page

from, 66–67
Find/Change command for searching,

303
hiding master items, 69
multiple pages, applying master to, 68
overriding master element, 68–69
page numbers, adding, 70–71
printing options, 384
scratch, creating master page from,

66–67
section numbers, adding, 70–71
Start Page and Numbering At option, 71
text variables, creating and using, 74–75
unassigning masters, 68–69

master text frames
changing, 34
with imported text, 92
new documents, selecting for, 28
Smart Text Reflow for, 411

Measure tool, 185
Media Files format, inserting files in, 16
meetings, Adobe ConnectNow toolbar for,

453
menus, 6. See also specific menus

colors for commands, 428
customizing, 428
InCopy menus, 440
shortcuts for menus, creating, 427

Menus template, 30
Merge Layers command, 183
merging. See also Data Merge

color swatches, 201
layers, 183

table cells, 260, 264
user dictionary into document, 417

metacharacters, 304
metadata. See also Adobe Bridge

description of, 449
documents, inserting file information

in, 402–403
Metadata panel, Adobe Bridge, 443
Microsoft Excel. See also XLS file format

tables, importing, 256–257
Microsoft Word

importing text from, 90
inserting files in documents, 16
styles from Word document, importing,

284–285
tables, importing text into, 256–257

Minus Back button, Pathfinder, 247
missing link preferences, setting, 425
miter join on strokes, 217
mixed inks, 206–207
monitors

colors, setting, 188
page size, setting, 29

More options for new documents, 29
Move Page command, 62–63
Movie command, 330
movies

adding, 330–331
options, setting, 330–331

moving. See also objects
with Adobe Bridge, 14
anchor points, 236
books, documents in, 77
color swatches, 201
frames and graphics, 144–145
graphics, 136
guides, 42
with Hand tool, 50
help topics, moving between, 23
pages, 62–63
segments, 236
tabs, 116
text, 101

multiple documents
arranging, 19
working with, 18

multiple pages, inserting, 59
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N
naming/renaming. See also Adobe Bridge;

layers
assignments, 436
bookmarks, 328–329
master page, 67
plug-ins, 429
styles, 284

navigating pages, 60–61
nesting

creating nested styles, 288–289
graphics in frames, 148
paragraph styles, setting, 279
tables, creating nested, 254

New Character Styles dialog box, 280
New Document dialog box, 32
new documents

presets, creating with, 32
template, creating from, 30

New Features, Welcome screen links to, 4
New Hyperlink From URL command,

322–323
New Paragraph Styles dialog box, 278
Newsletters template, 30
New Workspace dialog box, 52
next page, navigating to, 61
next spread, navigating to, 61
Nikon NEF format, 447
90-degree angles, drawing lines at, 156
Noise effect

with feather effects, 229
with glow, 227
with shadows, 226

nonbreaking space, inserting, 118
non-Latin text, setting preferences for, 412
non-printing content

Adobe PDF option, 365
in package files, 405
printing options for objects, 384

Normal view, 36
North American,

Prepress 2 color settings, 188
Purpose 2 color settings, 188
Web/Internet color settings, 188

notes. See also footnotes
to Adobe InCopy managed files, 433
creating, 316

Notes panel, working in, 317
preferences, setting, 420
tables, adding to, 316
text to notes, converting, 316, 317

Notes panel, 317
No Wrap option, 122
Numbering and Section Options dialog box

chapter numbers, adding, 72–73
master pages, page and section num-

bers for, 70–71
number of pages

changing, 34
master spread, specifying for, 67
new documents, selecting for, 28

numbers. See also bullets and numbering;
chapter numbers; number of pages;
page numbers

footnotes, numbering, 315

O
objects. See also anchor points; gradients;

graphics; layers
aligning, 166
anchored objects, creating, 177
blend effect, creating, 224–225
buttons, converting object to, 334–335
colors

applying, 193, 214
Eyedropper tool, using, 194–195
overprinting colors, 210

copying, 162–163
layers, copying objects between, 184
scaling and copying objects, 172

defaults, setting, 232
deleting, 157
deleting combined object, 165
Direct Selection tool

grouped objects, working with,
164–165

inline object, creating, 176
selecting with, 157, 159

distances and angles, measuring, 185
duplicating, 162–163
Find/Change command, using, 302–303,

308
flipping objects, 171
Free Transform tool, transforming

objects with, 170
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objects (continued)
grouped objects, 164–165

creating groups, 164
selecting objects in group, 165
ungrouping objects, 164

individual transformation, repeating, 174
inline object, creating, 176
library items, object types for, 345
locking/unlocking object position, 175
measuring distances and angles

between, 185
moving, 161

layers, moving objects between, 184
multiple objects, duplicating, 163
overlapping objects, creating compound

shapes from, 247
repeating transformations, 174
resizing, 160
rotating, 169–170

free rotating objects, 171
scaling, 160, 169–170, 172
searching for, 302–303, 308
Selection tool, 157

inline object, moving, 176
resizing objects with, 160

sequence of transformations, repeating,
174

shearing, 173
shortcuts for object editing, creating, 427
showing/hiding, 181
slipping objects, 172
Smart Guides for moving, 161
spacing, distributing objects with,

166–167
stack of objects, arranging, 168
styles

creating, 290–291
default object styles, modifying, 290

transformations, 169
repeating transformations, 174

Object Shape option, 122–123
older versions, updating from, 2
On Blur event for buttons, 336
On Click event for buttons, 336
On Focus event for buttons, 336
online activation of program, 2
Online Library panel, Adobe Device Central,

456

On release event for buttons, 336
On Roll Over event for buttons, 336
opacity, 11

for Gradient Feather effect, 229
Open dialog box, 12

deleting files in, 13
opening. See also Adobe Bridge

books, documents in, 76
closed paths, 240–241
existing document, opening, 12
libraries, 342
panels, 7
recently opening document, 13

Open Package command, 436
Open Path button for splitting paths, 240
OpenType, 104

character styles, setting, 281
glyphs, inserting, 117
highlighting text with, 413
paragraph styles, setting, 279

Open With command with Adobe Bridge,
134

OPI options
with Adobe PDF, 369
print options, 394

optical margin adjustment, setting, 311
optical size of fonts, setting, 410
Options menu

for panels, 8, 9
for tools, 11

ordinals. See glyphs
orientation

changing, 34
flipping print orientation, 391
for new documents, 28
printing setup options, 385

Outer Glow effect, 227
outlines, creating, 124
out of gamut, 192

converting out of gamut colors, 197
overflow text

changing thread between frames, 95
reshaping, 85
text on a path, correcting, 89
threading/unthreading, 94–95

overlapping objects, creating compound
shapes from, 247

Overlay blend mode, 224
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overprinting
colors, 210
paragraph rule, width of, 112
simulating, 391

Overprint Preview mode, 36–37
overrides. See also styles

Adobe PDF options, setting, 369
assignment files, locked, 439
print options, 394

P
Package for InCopy, 436
packages, creating, 404–405
PageMaker

file format, 12
Shortcuts for, 427

page numbers. See also number of pages
books, options for, 78–79
continued text, adding to, 125
general preferences, setting, 408
master pages, adding to, 70–71
for table of contents, 81

pages. See also facing pages; master
pages; Pages panel; spreads

Adobe PDF options, setting, 364
for bookmarks, 328
EPS file format options, 372
Flash movie, document exported as, 374
hyperlinks to, 320
inserting pages

multiple pages, inserting, 59
with Pages panel, 58–59

JPEG files, documents exported as, 380
objects to page, aligning, 166
Preflight panel options, 401
transitions, applying, 332
trap preset, assigning, 392–393
XFL for Flash, document exported as,

376
page size options

changing, 34
list of, 29
for new documents, 28
printing, setup for, 385

Pages/Links panel, 8
Pages panel. See also master pages;

spreads
deleting pages, 62

display, changing, 56
duplicating pages, 58
inserting pages with, 58–59
multiple pages, inserting, 59
navigating pages, 60–61
showing/hiding icons, 57
target a page, navigating with, 60
work on a page, navigating with, 60

page transitions
Flash movie, document exported as, 375
for Pages panel icons, 57

Page Transitions dialog box, 332
panel groups, 6

in Adobe InCopy, 440
panels, 6. See also Control panel; Pages

panel; Tools panel
in Adobe Device Central, 456
in Adobe InCopy, 440
collapsing/expanding, 7

panel set between icons and panels, 9
hidden panels, auto-showing, 409
icons, auto-collapsing, 409
Info panel, sizing object with, 51
opening/closing, 7
Options menu, using, 8, 9
panels, 8
shortcuts for panels, creating, 427
showing/hiding, 7, 36, 52

while you work, 8
Pantone color library, 202
Paragraph panel, InCopy, 440
paragraphs. See also bullets and number-

ing
aligning, 109
colors

rule, width of, 112
styles, setting, 279

creating, 98–99
cross-references, creating, 326
drop caps, creating, 111
indenting, 110

styles, setting, 279
Info panel, information in, 50
keeping lines together in, 310
rules, applying, 112–113
spacing, 110
in table cells, 265
table of contents, formatting for, 81
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paragraph styles
attributes, setting, 279
basic paragraph style, changing, 277
creating, 279
deleting, 278
existing text, creating from, 278
for table of contents, 80

Paragraph Styles panel, 276
password options in Adobe PDF, 370
pasteboard. See also guides

Show Entire Pasteboard option, 38
Paste In command, 164–165
pasting

Adobe Bridge, settings in, 450
Clipboard handling preferences, setting,

426
graphics, 136
layers while pasting, creating, 178
spacing, automatic adjustment of, 410
text, 101

patches, checking for, 20–21
Pathfinder command, 247
Pathfinder panel

Convert Shape buttons in, 231
Join or Close Path button, 242
Reverse button, 241

paths. See also clipping path; points;
reshaping; strokes

closed path, opening, 240–241
closing open path, 242
compound path, creating, 248–249
erasing parts of, 246
frames, importing paths as, 143
Pencil tool, drawing with, 244–245
Pen tool, drawing with, 234–235
reversing direction of, 241
selecting path as clipping path, 251
Smooth tool, using, 243
splitting paths, 240

PDAs (personal data assistants), RGB colors
for, 192

PDF file format, 361
advanced options setting, 369
and bookmarks, 328
for buttons, 336–337
buttons in, 333
Clipboard handling preferences, setting,

426

compression options, setting, 366
for data merged files, 354
exporting documents, 362
general options, setting, 364–365
graphic files saved in, 128
inserting files in, 16
Marks and Bleeds option, setting, 367
metadata to files, adding, 403
output options, setting, 368
for page transitions, 332
placing, 130–131
Preflight panel, creating PDF report in,

401
presets, 363

exporting with, 371
security options, setting, 370
table of contents, PDF bookmarks for, 81
tagged PDF, creating, 364

PD/FX options with Adobe PDF, 368
Pencil tool, 244–245
Pen tool, 234–235
perceptual colors, specifying, 191
phone activation of program, 2
Photoshop. See Adobe Photoshop
PICT file format

EPS file preview option, 373
WMFgraphic files saved in, 128

pirated versions, preventing, 2
Place command. See also graphics

with Adobe Bridge, 134
importing text with, 90–91
inserting artwork with, 16
multiple graphics, placing, 132–133

placing graphics. See graphics
plug-ins, configuring, 429
PNG file format

metadata to files, adding, 403
placing graphic files saved in, 128

pod panels, Adobe ConnectNow toolbar for,
453

points. See also anchor points
Convert Direction Point Tool, using, 237
defined, 41

Direct Selection tool
converting points on path with, 237

moving, 240–241
and fonts, 104
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ruler units preferences, setting, 414
Polygon Frame tool, 154
polygons

converting, 231
creating, 154–155
Pen tool, drawing with, 234

Polygon tool, 154
text, adding, 84, 86–87

portrait orientation
changing, 34
for new documents, 28

positioning
frames and graphics with Position tool,

144–145
printing setup options, 385

poster images for sounds and movies, 331
PostScript

EPS file format options, 372
points preferences, setting, 414

preferences. See also type preferences
camera raw preferences, setting, 446
Clipboard handling preferences, setting,

426
composition preferences, setting, 413
dictionary preferences, setting, 416–417
file handling preferences, setting,

424–425
general preferences, setting, 408
grid preferences, changing, 48–49
interface preferences, setting, 409
links preferences, setting, 425
notes preferences, setting, 420
restoring, 425
ruler units preferences, setting, 414
spell-checking preferences, setting,

418–419
Story Editor display preferences, setting,

422–423
Units & Increments preferences, 414–415

prefixes for master pages, 67
Preflight panel, 400–401

Status bar, accessing from, 17
preflight profile

Status bar, accessing from, 17
using, 400–401

presets. See also PDF file format
in Adobe Bridge, 450
deleting, 32–33, 383

printing with, 383
saving, 32
text variables, 74
transparency flattener preset, creating,

395
trapping preset, creating, 392
working with, 33

previewing. See also Adobe Bridge
color separations, 389
data merge data, 355
EPS file format options, 373
guide color for backgrounds, specifying,

44
images, saving, 24–25
overprinted colors, 210
page transitions, 332
save preferences, setting, 424
text frame options, 120

Preview panel, Adobe Bridge, 443
Preview view, 36
previous page, navigating to, 61
previous spread, navigating to, 61
Print command, 382
printers' marks options with Adobe PDF,

367
printing. See also overprinting; spreads;

trapping
Adobe PDF print options, 363
advanced options, setting, 394–395
auto options, 385
booklet, spreads in, 398–399
books, 77
color handling options, 396
Color Management options, setting, 396
color separations, previewing, 389
data format options, 388
documents, 382
flattened artwork, 395
general options, setting, 384–385
graphics print options, setting, 388
Help topics, 23
keyboard shortcuts, list of, 427
layers, 180
marks and bleed print options, setting,

386–387
negative option, 390
output options, setting, 390–391
package files, print settings in, 404
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printing (continued)
preflight profile, using, 400–401
preserving color numbers, 396
with presets, 383
profile, setting, 396
sets, working with, 427
setup print options, setting, 384–385
simulating paper color option, 396
summary print options, 397
text as black, 390
transparency flattener preset, creating,

395
Printing and Proofing workspace, 52–53
Profile Inclusion Policy with Adobe PDF, set-

ting, 368
projecting caps on strokes, 217
proofing colors on screen, 211
PSB file format for raw images, 446
PSD file format

importing images, options for, 129,
130–131

metadata to files, adding, 403
placing graphic files saved in, 128
raw images, saving, 446

Q
quality

Adobe PDF, setting image quality with,
366

JPEG files, documents exported as, 380
QuarkXPress

file format, 12
Shortcuts for, 427

Quick Apply, 11
for styles, 294–295

Quick Search, Adobe Bridge, 443
Quit InDesign command, 26
quotation marks

dictionary preferences, setting, 417
inserting, 118
typographer's quotes, using, 410

R
Radial gradients, 204
radius value in Corner Options dialog box,

231
range of page option for printing, 384

rasterizing
Flash movie, document exported as, 375
XFL for Flash, document exported as,

377
raw images. See Adobe Bridge; DNG file

format
recently opening document, opening, 13
records for Data Merge, 354
Rectangle Frame tool, 154
rectangles

converting, 231
creating, 154

Rectangle tool, 154
text, adding, 84, 86

red-eye removal with camera raw files, 447
reference number for footnotes, 315
reference point

for fitting graphics in frames, 147
objects, transforming, 169

reflowing text, 411
Smart Text, 96–97

registration marks, printing, 387
relative colorimetric, specifying, 191
Release Compound Path command,

142–143
releasing compound paths, 142–143, 249
relinking. See also graphics

cross-references, 327
renaming. See naming/renaming
repeated words, spell-checking preferences,

418
replacing

books, documents in, 77
importing text, replacing item with, 90
table of contents, 81

reports for page files, creating, 404
resetting

all warning dialogs, 408
cross-references, 327

reshaping
anchor points or segments, 236
erasing to reshape paths, 246
Pencil tool, paths with, 244

resizing. See sizing/resizing
resolution

Adobe PDF setting options, 366
Info panel, information in, 50
JPEG files, documents exported as, 380
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resource help, 22–23
restoring preferences, 425
retouching with camera raw files, 447
revealing documents

in Adobe Bridge, 15
in Status bar, 17

reverse order option for printing, 384
reversing fill in compound path, 249
RGB (Red, Green, Blue), 192

Adobe PDF options, setting, 368
Color panel, selecting with, 196
EPS file format options, 372
Working Space controls, 188–189

right-aligning paragraphs, 109
right indents, creating, 110
right side, dragging text to, 89
RIP (Raster Image Processing), 390, 392
rotating, 11. See also objects; spreads

with Adobe Bridge, 14
camera raw files, 447
Spread view, 37
tables, text in, 265

Rotation and Shear Angle, 11
round bullets, 114–115
round caps on strokes, 217
Rounded corner options, 230
round join on strokes, 217
RTF file format, 361

importing text from, 90
inserting files in, 16

rulers
changing ruler options, 40
guides

appearance, changing, 44–45
movement, allowing, 82

measurement units, changing, 41
origin, changing, 41
paragraph rule, applying, 112–113
showing/hiding, 41
units preferences, setting, 414
working with, 41

rules for paragraph styles, setting, 279
run-in style table of contents, 81
Running Header text variable, 74

S
sample, creating buttons from, 334

sampling options for Adobe PDF, 366
satin effect, 227
saturation, specifying, 191
Save As dialog box, 13
saving

books, 77
camera raw images, 447
color swatches, 201
copy of document, 25
documents, 24–25
file handling preferences, setting, 424
gradients, 205
presets, 32
print summary, 397
Web Photo Gallery, 451

Scale X and Y, 11
scaling

Flash movie, document exported as, 374
general preferences, setting, 408
Info panel, information in, 50
objects, 160, 169–170, 172
printing setup options, 385
shortcuts for scaling, creating, 427
text, 108
XFL for Flash, document exported as,

376
Scissor tool for splitting open paths, 240
screen fonts, 104
scripts

editing scripts, 352
general preferences, setting, 408
running scripts, 352–353

Scripts panel, 352–353
SCT file format, WMFgraphic files saved in,

128
searching. See also Find/Change command

in Adobe Bridge, 14, 448
for fonts, 301
for glyphs, 302–303, 306
for GREPs, 302–303, 306
for help information, 22–23
in libraries, 346
for objects, 302–303, 308
spell-check options, 299

sections
books, updating section numbers in, 79
master pages, adding numbers to, 70–71
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security
Adobe PDF security options, setting, 370
JavaScript, enabling or disabling, 408

segments
deleting, 239
moving, 236
Pencil tool, drawing with, 244
reshaping, 236
selecting, 236
splitting paths in middle of, 240

selecting
anchor points, 236
frames and graphics, 144–145
segments, 236
text, 98–99

Selection tool. See also Direct Selection
tool; objects

fitting frames in graphics with, 146
objects, selecting, 157
selecting and moving frames and graph-

ics with, 144
with Smart Guides, 46

Send Backward in object stack, 168
Send to Back in object stack, 168
Sentence case, creating, 312
Separations Preview mode, 36–37
servers in Adobe InCopy, working with, 432
shadow effects, 226

Drop Shadow effect, 11, 226
shapes. See also reshaping; specific shapes

compound shapes, creating, 247
converting shapes, 231
creating, 154–155
with Smart Guides, 46

Share My Screen command, 442, 453
sharing. See Adobe InCopy; assignments;

interactive documents
shearing objects, 169–170, 173
Shear tool, 173
shortcuts. See also keyboard shortcuts

Macintosh computers, creating shortcuts
on, 5

showing/hiding. See also hidden text; lay-
ers; panels

grids, 48
guides, 43
icons, 428
master items, 69

notes, 317
objects, 181
Pages panel icons, 57
plug-ins, information on, 429
rulers, 41
separation inks, 388
Tools panel, 36

Show Text Threads command, 94–95
sidecar files, 449
signature for booklet pages, 399
simulating overprinting print option, 391
single quotation marks, inserting, 118
single word justification, 311
sizing/resizing. See also graphic frames;

graphics; page size options
icon size for Pages and Masters, specify-

ing, 56
Pages panel, 56
shortcuts for sizing, creating, 427

skewing text, 108
slug area

Adobe PDF options, 367
changing values, 34
guide color, specifying, 44
for new documents, 28–29
page numbers in, 62

Slug view, 36
small caps, 412

styling text as, 102–103
Smart Guides, 46–47

objects, moving, 161
with Pen tool, 234
preferences, changing, 47

Smart Match Style Group synchronize
options, 78

smart spacing, 47
Smart Text Reflow, 96–97

options, selecting, 411
Smooth tool, 243
Smooth Tool Preferences dialog box, 243
snapping options, adjusting, 82
Snap to Document Grid command, 49
Snap to Guides command, 42–43
Snap to Zone, 44, 47
snippets

creating, 348–349
dragging, creating by, 348–349
import options, setting, 425
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using, 348–349
Soft Light blend mode, 224
soft proofing colors on screen, 211
Soft Proofs mode, 36–37
soft returns, forcing, 98–99
Solid Color Intent option, 190
sorting

with Adobe Bridge, 14
bookmarks, 329

Sound Options dialog box, 330–331
sounds

adding, 330–331
options, setting, 330–331

source files
for cross-references, 327
for hyperlinks, 320
for linked graphics, 137

spacing
automatic adjustment of, 410
footnotes, 315
glyph spacing, 311
letter spacing options, 311
objects with spacing, distributing,

166–167
paragraphs, 110
paragraph styles, setting, 279
Story Editor display, setting, 422
table columns and rows, evenly distrib-

uting spacing of, 262
text on a path, 89
word spacing options, 311

Spanish typefaces, 412
special characters. See characters
specialty frames for graphics, creating,

142–143
spell-checking. See also dictionaries

Autocorrect fixing errors, 100
documents, 298–299
dynamic spelling, 298, 299, 419
note content, 420
options, 299
preferences, setting, 418–419

spine, aligning paragraphs to, 109
splitting

paths, 240
table cells, 264

spot colors and mixed inks, 206–207
Spread effect

with glow, 227
with shadows, 226

spreads
adding/removing pages from, 64
EPS file format options, 372
facing-page spreads, preserving, 411
Flash movie, document exported as, 374
island spreads, 64
JPEG files, documents exported as, 380
object to spread, aligning, 166
page transitions, applying, 332
printing, 384

booklet spreads, 398–399
rotating, 37, 65

Pages panel icons, 57
XFL for Flash, document exported as,

376
spreadsheets, links preferences when plac-

ing, 425
stacking

Adobe Bridge, images in, 14, 449
object stack order, arranging, 168

StandardSoundPoster.jpg, 330
star shape

creating, 154–155
frame for text, creating, 87

starting InDesign CS4, 4–5
Start menu, 13
Start Page and Numbering At option, 71
Status bar

pages, navigating between, 60–61
working with, 17

Step and Repeat command
grid, creating, 163
objects, copying, 162

stories
Adobe InCopy, exporting content to, 434
Find/Change command, searching story

layers with, 303
Story Editor

background color for notes in, 420
display preferences, setting, 299,

422–423
drag-and-drop editing in, 101
tables, editing text in, 258–259
working with, 313

straightening camera raw files, 447
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strikethrough options
character styles, setting, 281
paragraph styles, setting, 279

Strikethrough text, 102–103
Stroke panel, 8, 156
strokes. See also gap color/tint; tables

alignment of stroke on path, changing,
216

applying strokes, 193, 214-215
attributes, changing, 216–217
caps, changing, 216–217
converting, 231
custom-dashed stroke, applying, 218
custom styles, creating, 218–219
dashed/dotted strokes

applying, 218
creating, 218–219
gap color for, 217

defaults
for colors, 214–215
setting, 232

drawing, 156
Eyedropper tool, using, 194–195
Info panel, information in, 50
joins, changing, 216–217
styles, 217–219

custom styles, creating, 218–219
dashed stroke style, applying, 218

Structure pane for placing XML tags,
356–358

styles. See also character styles; GREPs;
objects; paragraph styles; strokes;
tables

applying, 286–287
for bullets, 114–115
case-sensitivity of names, 284
cell styles, creating, 292
Character Styles panel, 276
clearing style overrides, 286–287
for cross-references, 326
deleting table and cell styles, 293
editing with Quick Apply, 295
End Nested Style Here special character,

288–289
font style, changing, 102–103
groups, creating, 283
for hyperlinks, 325
importing styles, 284–285

InDesign document, loading styles from,
284

letter commands with Quick Apply, 295
links to style, breaking, 286
loading styles, 284
Microsoft Word document, importing

styles from, 284–285
nested styles, creating, 288–289
overriding

formatting, 286–287
object style overrides, clearing, 291

paragraph rule, width of, 112
with Paragraph Styles panel, 276
Quick Apply, using, 294–295
renaming styles, 284
table styles, 292–293

Style Source setting for books, 78
subsampling with Adobe PDF, 366
subscript, 102–103

advanced type settings for, 412
Subtract button, Pathfinder, 247
summary

for booklet pages, 399
print options, viewing summary of, 397

superscript, 102–103
advanced type settings for, 412

swapping text on path, 89
swashes. See glyphs
Swatches panel. See also gradients

adding color swatch, 199
all unnamed colors, adding, 201
for button colors, 338
Color Picker, adding colors from, 215
deleting color swatch, 199, 200
display, changing, 198
editing color swatch, 199
fill or stroke color, changing, 214
gradient swatches, creating, 204–205
Kuler panel, adding, 208
loading swatches, 201
merging color swatches, 201
mixed inks with, 206–207
moving swatches, 201
name of swatch, entering, 199
saving swatches, 201
selecting swatches, 201
tint swatches, creating, 203
working with swatches, 200–201
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swatch libraries, adding colors from, 202
SWF file format, 360, 361

exporting document in, 374–375
switching between pages in Status bar, 17
symbols

@ before field name, adding, 354
Autocorrect, inserting with, 100
inserting, 118

synchronizing
books, 78
camera raw images, 447

System color library, 202
system requirements, 3

T
table of contents

creating, 80–81
for digital editions, 378

Table Options dialog box, 273
tables

adjusting options, 256
aligning content in cells, 265
alternating fills and strokes in, 270–271
borders, adding, 273
clipping for graphics, setting, 265
colors

for borders, 273
for diagonal lines in cells, 272
strokes and fills, setting for, 270–271

columns and rows, inserting, 261
Control panel, modifying tables with,

260
converting

tables to text, 255
text to tables, 255

defined, 253
deleting

cell contents, 258
columns and rows, 261
table and cell styles, 293

diagonal lines in cells, adding, 272
dimensions, specifying, 254
editing text in tables, 258–259
elements, selecting, 258
fills

adding, 268–269
alternating fills, 270–271

gap color/tint
for borders, 273
for diagonal lines in cells, 272
tables, strokes in, 271

graphics
clipping for graphics, setting, 265
importing graphics, 256

headers and footers, 266–267
converting cells and, 267

height, weight, width
adjustment options, 263
for borders, 273
elements, specifying, 260

importing
graphics into tables, 256
text into tables, 256–257

merging/unmerging cells, 260, 264
Microsoft Excel tables, importing,

256–257
Microsoft Word text, importing, 256–257
modifying, 260–261
navigating in tables, 258
nested tables, creating, 254
new table, creating, 254
notes, adding, 316
spacing of columns and rows, evenly

distributing, 262
splitting cells, 264
Story Editor, using, 258–259
strokes

adding, 268–269
alternating strokes, 270–271
cells, adding to, 268–269
diagonal lines in table cells, adding,

272
drawing order, setting, 268
style and weight, specifying, 260

styles, 292–293
Table panel, modifying tables with, 260
text

converting tables and text, 255
editing text in tables, 258–259
entering text in tables, 258
importing text, 256–257
rotating, 265
Story Editor, editing text with,

258–259
text frames, adjusting tables in, 274
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tabloid page size, 29
Tab Order dialog box, 339
tabs

for bullets and numbering, 115
button tab order, setting, 339
paragraph styles, setting, 279
setting, 116
stops, defined, 116

target a page, navigating with, 60
templates

creating template document, 31
new document, creating, 30
saving document as, 25
for Web Photo Gallery, 451

Terminal theme, 422
Testing panels, Adobe Device Central,

456–457
text. See also character styles; fonts; hidden

text; kerning; overflow text; para-
graphs; paragraph styles; Smart Text
Reflow; Story Editor; tables; text
frames; tracking; type preferences;
wrapping text

Autocorrect options, 100
autoflowing imported text, 93
baseline, shifting characters from, 105
black, printing text as, 390
for bookmarks, 328
with bullets, 114–115
for buttons, 338
colors in Story Editor display, 422
conditional text, working with, 350–351
copying, 101
cutting, 101
documents, inserting text in, 16
dragging text, 101
Find/Change command, using, 302–303,

304
Frame tools, adding with, 84, 86
greeked text, 411
importing text, 90–91

autoflowing imported text, 93
continued text, adding page numbers

to, 125
flowing imported text, 92–93
with options, 90–91

Info panel, viewing in, 51
inherited formatting for dragged text,

101

leading text, 105
links preferences when placing, 425
notes, converting text to, 316, 317
overflowing text, reshaping, 85
pasting, 101
reflowing, 96–97
scaling text, 108
searching, 302, 303–304
selecting, 98–99
skewing text, 108
special text characters, inserting, 118
Type of a Path tool, using, 84
typing text, 98

text breaks, inserting, 118
text frames. See also assignments; over-

flow text
baseline options, 121
creating text in, 85
elliptical frame, creating, 86
ignoring text wrapping in, 121
options, setting, 120–121
outlines, creating, 124
overflowing text, reshaping, 85
polygon frame, creating, 87
rectangle frame, creating, 86
searching for, 308
star frame, creating, 87
tables, adjusting, 274
wrapping text, 85, 123

ignoring text wrap, 121
Text Only file format, 361
text variables

defining, 74
working with, 75

themes
Kuler panel, using colors from, 208–209
Story Editor display, setting, 422

threading/unthreading overflow text, 94–95
3-D bevel effect, 228
threshold

for grids, 49
for guides, 45

thumbnails
Adobe PDF options, setting, 364
library items, displaying, 347
options for showing, 409
in Pages panel, 56
printing setup options, 385
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TIFF file format
Adobe Bridge, opening with, 446
EPS file preview option, 373
importing images, options for, 129, 131
for metadata, 403, 449
placing graphic files saved in, 128
raw images, saving, 446

tiling documents, 19
Times New Roman font, 102
tints. See also gap color/tint

dashed/dotted lines, tint color for, 217
paragraph rule, width of, 112
swatches, creating, 203

Title Case, creating, 312
tone curve for camera raw images, 447
tools. See also specific tools

keyboard shortcuts for, 10
shortcuts for tools, creating, 427

Tools panel, 6
for InCopy, 440
keyboard shortcuts, 10
showing/hiding, 36
using, 10–11

tooltips
note tooltips, showing, 420
options for showing, 409

top and bottom margins. See margins
Toyo color library, 202
tracking, 107

highlighting text with, 413
increments preferences, setting, 414–415

Tracking and Indentation option, Type tool,
11

Transform Again submenu, 169
transformation. See also objects

values, showing, 409
transitions. See page transitions
transitions for pages, displaying, 332
transparency

Adobe PDF options, setting, 369
blend, create effect with, 225
color space for blending transparent

objects, 225
importing, 129, 130
for Pages panel icons, 57
print options, 394–395
XFL for Flash, document exported as,

377

trapping, 390
assigning trap presets to pages, 392–393
preset, creating, 392

Trap Presets panel, 392
triangles, converting, 231
triple-click, changing action of, 99
TrueType fonts, 104
Trumatch color library, 202
turning on/off

Adobe Version Cue, 454
Smart Guides, 46

2-up perfect bound for booklet, printing,
398

2-up saddle stitch for booklet, printing, 398
TXT file format

data fields, 354
importing text from, 90
inserting files in, 16

Type on a Path tool, 84
creating text on path, 88
deleting text on path, 88
modifying text on path, 89

type outlines as frames, creating, 143
type preferences

advanced preference, setting, 412
general preferences, setting, 410–411

Type tools
options with, 11
text frame, creating text in, 85
using, 84

typing text, 98
typographer's quotes, using, 410
Typography workspace, 52–53

U
unassigned frames, 153, 154

searching for, 308
underlining, 102–103

character styles, setting, 281
conditional text, 359
paragraph styles, setting, 279

undoing/redoing, 53
updates and updating``

assignments, 439
data merge sources, 355
Help menu, checking on, 21
hyperlinks, 324
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updates and updating (continued)
Internet, checking for updates on, 20
library items, 344
package files, 404

uploading Web Photo Gallery, 451
uppercase text, creating, 312
URLs. See hyperlinks
user dictionary preferences, 416

V
vector-based images, inserting, 16
Version Cue. See Adobe Version Cue
vertical lines, converting, 231
vertically tiling all documents, 19
vertical spacing in text, changing, 105
videos. See movies
views and viewing. See also display; rulers

InCopy views, 432
InDesign window, 6
object styles, 290
page transitions, 332
print summary, 397
Zoom tool, changing view with, 38–39

Visibility icon, 428
visibility settings

for cross-references, 326
for hyperlinks, 325

Visual Basic scripts, 352
visually impaired persons, PDF options for,

370

W
warning dialogs, resetting, 408
Web color library, 202
Web Photo Gallery, creating, 451
Web sites

hyperlinks to, 320
weight. See height, weight, width
Welcome screen

Open dialog box, 12
opening document from, 13
starting InDesign CS4 from, 4

What's New, finding, 23
white space, inserting, 118
width. See height, weight, width
Windows menu, 18–19

System color library, 202

WMF file format, graphic files saved in, 128
Word. See Microsoft Word
words

Info panel, information in, 50
spacing options, 311

Working Space color controls, 188–189
work on a page, navigating with, 60
workspaces. See also Adobe Bridge

built-in workspaces, 52
creating, 52
deleting, 53
displaying, 53

wrapping text. See also text frames
composition preferences, setting, 413
contour options, 123
inside edges, including, 123
layers, preventing wrapping in, 180
objects, wrapping and unwrapping

around, 122
setting shape wrap options, 123

WYSIWYG font menu, 410–411

X
XFL file format, 360

exporting document as, 376–377
XHTML format for eBooks, selecting, 378
XLS file format

importing text from, 90
inserting files in, 16

XML file format, 361
creating XML tags, 356
document, placing XML tags in, 356–357
elements in, 356
exporting XML, 358
importing XML tagged data, 356–357

XMP file format, 449
documents, inserting file information in,

402–403
linked graphic, displaying information

for, 141
XMP Software Development Kit, 403

Z
zooming in/out

in camera raw files, 447
image view, 38–39
shortcut keys for, 39


	Introduction
	3 Managing Pages and Books
	Using the Pages Panel
	Inserting Pages
	Navigating Pages
	Deleting or Moving Pages
	Working with Page Spreads
	Rotating Page Spreads
	Creating Master Pages
	Working with Master Pages
	Working with Page Numbers and Sections
	Working with Chapter Numbers
	Creating and Using Text Variables
	Creating a Book
	Managing Books
	Creating a Table of Contents
	Adjusting Layouts

	Index
	A
	B
	C
	D
	E
	F
	G
	H
	I
	J
	K
	L
	M
	N
	O
	P
	Q
	R
	S
	T
	U
	V
	W
	X
	Z




